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Preface by Neil J. Pedersen, Administrator 

It gives me great pleasure to introduce the latest edition of the SHA CAD Standards: 
2004 Edition. A great deal of work and coordination went into this manual’s 
development. The IDS Team was instrumental in pulling resources together from 
across SHA and the consultant community. The involvement of representatives from 
across SHA on the SHA IDS CAD Subcommittee was a key factor. And finally, the 
membership of the Consulting Engineering Council of Maryland volunteered its time 
and provided valuable incite and feedback on the SHA IDS CAD Subcommittee.  

Whether you work at SHA to produce CAD drawings, or are a consultant responsible 
for design drawing deliverables on SHA projects, this latest edition of the SHA CAD 
Standards outlines the best practices you must adhere to for all SHA-related 
engineering work. 

Available with this manual is a CD containing support files such as standard borders, 
seed files, cell libraries, and a menu bar application to help deploy and adhere to 
standards on SHA projects. The Standards and associated support files are also 
available on the SHA Web site. 

The standards have been developed to work for you and should be considered a living 
document that will evolve over time to better serve you.  Should you have any 
questions, concerns, or suggestions for improving the content, feel free to contact the 
SHA IDS Team at ids@sha.state.md.us.  

Neil J. Pedersen  
Administrator 
Deputy Administrator – Planning and Engineering 
Maryland State Highway Administration  
Baltimore, Maryland 
July 2004  

mailto:ids@sha.state.md.us
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Introduction 

This chapter introduces the contents of SHA CAD Standards: 2004 Edition.  Readers 
will also identify the people who developed the SHA CAD Standards.  This chapter’s 
two major sections are listed below: 

• About this Manual describes the intended audience, the purpose of this 
manual, a chapter-by-chapter summary, typographic conventions, bundled 
compact disc contents, a glossary, and changes since the last version. 

• Acknowledgments and Contributions introduces the IDS Team and the 
CAD Standards Subcommittee, whose members developed the Standards. 

About This Manual 
This manual was completely rewritten to include all CAD documentation previously 
used throughout SHA.  We hope that this manual will serve as the single information 
source related to the use of CAD at SHA, regardless of the Office and Division you 
serve. 

This manual also marks SHA’s migration to the V8 generation of MicroStation and 
related engineering design add-ons and custom applications.  Whether you are 
looking for information on drawing setup, element symbology tables, productivity 
tools, printing, redlining procedures, or other CAD topics, flip through these pages. 
You are sure to find the answers here. 

The IDS Team is committed to updating this manual regularly to respond to the 
changing needs of our industry, including new developments in CAD and related 
technologies that encompass MicroStation and ProjectWise.  We would love to hear 
from you.  Please contact the IDS Team (ids@sha.state.md.us) with your comments 
and suggestions. 

The Audience 
This manual serves the needs of several CAD users: 

Designers and Engineers at SHA: If you are a new SHA employee beginning your 
first project, this manual will help you become familiar with the design workflow, 
especially those aspects related to CAD. If you have designed projects for years and 
find yourself explaining the same processes to new designers and engineers, we hope 
that you will rely on this manual to help with such training. 

mailto:ids@sha.state.md.us
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Regardless of your experience level, you should find the information easy to locate 
and presented in a manner that can be put to use right away. 

Engineering Consultants: If you are a consultant tasked with a project for SHA, you 
will find all the drawing setup procedures necessary to create new MicroStation 
design files. You will also find tables that will help you use provided tools to set the 
desired symbology (level, color, weight, and style) for design elements. Following the 
guidelines set in this manual will ensure that the drawings you produce are consistent 
with current SHA CAD Standards. 

Construction Contractors: As a contractor, your job is to read design drawings for 
constructing highways, bridges, traffic signs, and hydraulic and ancillary structures. 
Though not as relevant to your needs, this manual will help you better understand the 
drawing setup, especially when you are called upon to prepare shop drawings, 
changed field condition sketches, redline drawings, and the like. 

Purpose  
The purpose of this manual and its associated electronic files and tools is threefold: 

1) Quality of Deliverables: These Standards are built upon SHA’s several decades in 
the successful design and construction of highway and traffic projects statewide. The 
documentation of this solid foundation of past experience ensures that the 
deliverables you produce based upon them are of a superior quality. 

2) Efficiency in Design through Tools: The cell libraries, menu files, Standard 
details, and other files that accompany this manual are designed to help you quickly 
place standard graphical elements with just a click or two. Additionally, custom 
design tools and macros let you more efficiently create design elements, including 
drainage structures, traffic signals, right-of-way plats, bridge detail sheets, and more 
in your drawings. 

3) Consistency between Offices and among Consultants: By using the details, 
symbols, seed files, and notes presented in these Standards, you ensure that drawings 
you create conform to SHA’s requirements and are consistent—regardless of who 
works on them. 

By properly using the concepts and tools outlined in this manual, you will be better 
equipped to produce high-quality CAD drawings more efficiently and consistently. 

Typographic Conventions 
Subject areas are easy to find by noting the typography. For example, regular content 
appears in 12-point Times Roman.  Chapter titles appear in the 18-point bold Arial 
font. Main chapter headings use the 14-point bold Arial font.  Chapter subsections are 
italicized and use the 14-point bold Arial font. Bulleted-list subheads use Arial 11-
point bold.  
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E-mail addresses appear as hyperlinked text.  When referencing Web sites, the 12-
point Courier New font is used.  Sections with programming code and filenames also 
employ 12-point Courier New for easier reading.  The Glossary included in Appendix 
A helps readers locate specific meanings of terms. 
 
The “What’s Next?” portion at the end of each chapter summarizes the next chapter’s 
contents.  The “Notes” section provides space for users to take notes.  

Bundled Compact Disc Contents 
The root directory of the compact disc contains the file toc.htm that describes the 
directory organization and the accompanying files, including border files, cell 
libraries, font and line style resource files, custom tools, workspace files, and element 
symbology tables. 

Changes since the Last Version 
It is worthwhile to note the content changes of this book since SHA released the last 
comprehensive CAD Standards in 1995.  Since that release, new technologies and 
Standards have been adopted.  This manual has been updated to describe these 
revisions and additions to the CAD Standards, below: 

• Upgrade to MicroStation V8 

• Standard workspace development 

• File naming and level naming 

• Adoption of ProjectWise and its integration with MicroStation V8 

• More concentrated focus on tools and add-ons 

• Changes to CAD terms used in the CAD Standards 

• Standardized plotting methods 

• Drafting workflow guidelines 

• History of CAD at SHA 
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Acknowledgments and Contributions 
The development of CAD Standards for an organization the size and scope of SHA 
requires sponsorship, effort, and contributions from numerous sources.  The SHA IDS 
Team led the development effort and coordinated feedback from across the entire 
organization and from its consultant community. 

The following section about the IDS Team and the IDS Initiative at SHA is based 
upon the preface signed by Neil Pedersen and Doug Rose in 2001 for the IDS 
Strategic Plan. 

SHA IDS Team 
To help the organization improve its design production procedures and processes, the 
SHA Chief Engineer’s office sponsored a production forum in late 1999 to solicit 
innovative employee ideas.  

The forum was an intensive one-day event and was comprised of engineering teams 
assigned the task of discussing the ways and means that design production could be 
improved.  One team focused on using Information Technology to automate and 
improve design and production processes.  The team identified the need to nurture a 
program that has become the IDS Initiative. 

This Initiative went through a gestation period during which, with backing from 
senior management at SHA, an informal team gathered to develop a strategic plan to 
identify its role and scope.  This team conducted research, set up pilot projects, 
increased awareness of issues, and developed useful design tools. 

Recognizing that the results of the IDS Initiative had the potential to make an 
enormous impact on the whole organization, Doug Rose and Neil Pedersen decided to 
formalize the initiative and assign it a full-time manager.  Michael Lynch accepted 
the challenge to keep the IDS Initiative on track.  He began his tenure as the manager 
of the IDS Team on August 1, 2001 in the Office of Highway Development. 

SHA IDS CAD Standards Subcommittee 
The development of this edition of the SHA CAD Standards was among several 
important initiatives undertaken by the IDS Team. An IDS CAD Standards 
Subcommittee was formed to represent CAD users and managers across the entire 
SHA community and from its consultant community, represented by the Consulting 
Engineering Council of Maryland. 

The following table lists members of the SHA IDS CAD Standards Subcommittee. 
They supported the IDS Team by providing valuable technical insight into SHA’s 
needs and approved the content of these Standards. 
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Name Representing 
Adrian Van DeLangerijt CEC Johnson, Mirmiran & Thompson 
Alex Soutar OFIT Information Technology Division 
Amy K. Beall OOTS Traffic Engineering Design Division 
April Parsons Maryland Transit Authority (RK&K) 
Barb Henry IDS Team (E3Synergy) 
Barb Solberg Office of Highway Development 
Bob Greene CEC Wallace, Montgomery & Associates 
Bill Cain Maryland Port Administration 
Bill Carver OPPE Project Planning Division 
Bill Schaub CEC Wallace, Montgomery & Associates 
Bradley Sorrell Maryland Department of Transportation 
Brian Crocetti Office of Highway Development 
Brian Lawrence District 6 
Cheri Wyckoff CEC McCormick, Taylor & Associates 
Chuck Rheault CEC Greenman-Pedersen, Inc. 
Cornelius Barmer Office of Highway Development 
Cyrus McCall CEC McCormick, Taylor & Associates 
Daryoosh Mosleh Office of Traffic and Safety 
Debi Adkins CEC RK&K 
Deborah Krebs Baltimore Gas and Electric 
Doug Dillon OHD Plats and Surveys Division 
Duane Pennington OHD Plats and Surveys Division 
Eric Marabello OHD Highway Design Division 
Eric Sender CEC Wallace, Montgomery & Associates 
Galina Bocharov District 5 
Gelacio Dela Cruz OPPE Highway Information Services Division 
Greg Cooley OPPE Highway Information Services Division 
James Shiu IDS Team (ECO Integration) 
Jake Smith CEC STV Inc. 
Jane Wagner OPPE Project Planning Division 
Jim McDonnell CEC Johnson, Mirmiran & Thompson 
Jim Ridenour CEC RK&K 
Joanne Gales OOTS Traffic Engineering Design Division 
Joel Trotta Office of Environmental Design 
John Schouten Constellation Design Group 
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Name Representing 
Karl Sumwalt IDS Team (KCI) 
Kevin Law OHD Highway Design Division 
Kim Alan Musser District 1 
Lauren Baker Office of Maintenance 
Mark Van Wert IDS Team (E3Synergy, RAM) 
Matt Parlakian OHD Highway Hydraulics Division 
Matt Zulkowski Office of Bridge Development 
Maurice Price Office of Maintenance 
Michael Stewart OHD Highway Hydraulics Division 
Mike Lloyd District 7 
Mike Lynch IDS Manager 
Patrick Meinecke Office of Bridge Development 
Paulo Desousa Office of Materials and Technology 
Prashanth Talanki IDS Team (RAM Consulting Corporation) 
Ranjit Sahai IDS Team (RAM Consulting Corporation) 
Robert Burris Maryland Transit Administration 
Salvatore Cross CEC Century Engineering 
Scott Rose Maryland Transit Administration (RK&K) 
Shari Lance CEC McCormick, Taylor & Associates 
Sharon Yohn OHD Highway Design Division 
Sippy Joseph IDS Team (RAM Consulting Corporation) 
T.J. Spampinato Office of Environmental Design 
Todd Lawrence District 6 
Tony Crawford SHA, District 6 
William (John) Gover Office of Highway Development 

Content Developers 
The following people contributed to the writing of this manual and to the 
development of these revised Standards. 

Name Representing 
Barb Henry IDS Team (E3Synergy) 
Carrie Smoot IDS Team (RAM Consulting Corporation) 
Cheri Wyckoff IDS Team (McCormick Taylor) 
Chris Fleming IDS Team (Sabra, Wang & Associates) 
Cyrus McCall IDS Team (McCormick Taylor) 
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Name Representing 
Eugene Staten IDS Team (RAM Consulting Corporation) 
James Shiu IDS Team (ECO Integration) 
Karl Sumwalt IDS Team (RAM Consulting Corporation) 
Mark Van Wert IDS Team (E3Synergy, RAM) 
Michael Lynch IDS Team (RAM Consulting Corporation) 
Michael Tucker IDS Team (RAM Consulting Corporation) 
Nellie Mikhalnyuk IDS Team (Sabra, Wang & Associates) 
Ranjit Sahai IDS Team (RAM Consulting Corporation) 

Tool Development 
The following organizations contributed to the development of various custom tools 
and programs that are included with the new standards: Alpha Corp, E3Synergy, ECO 
Integration, KCI, RAM Consulting Corp, RK&K, University of Maryland 

Special Thanks 
The following individuals deserve special thanks for their tireless efforts in testing the 
and providing feedback.  Any oversights in the standards will not be for lack of effort 
on their part. 

Name Representing 
Chuck Rheault CEC Greenman-Pedersen, Inc. 
Dawn Wyatt CEC Wilson T. Ballard Company 
Jeff Redding CEC Gannett Fleming 
Matt Parlakian OHD Highway Hydraulics Division 
Michael Tucker IDS Team (RAM Consulting Corporation) 
Philip Mashuda CEC Johnson Mirmiran & Thompson 
Salvatore Cross CEC Century Engineering 
Sharon Yohn OHD Highway Design Division 
Teresa Milton OHD Highway Design Division 

 

What’s Next? 
Chapter 1 provides an introduction to the SHA Workspace, which delivers the new 
CAD Standards in the MicroStation V8 environment.  Minimum system requirements 
are detailed.  Administrators will learn how to set up the Workspace for their office, 
and users will learn how to use the Workspace Options. 
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Chapter 1 
SHA Workspace 

This chapter provides an introduction to the SHA Workspace that has been developed 
for use with MicroStation V8.  This workspace helps users manage the V8 drafting 
environment by delivering standard elements such as resource files, cells and level 
libraries, as well as several custom tools and macros developed by SHA for V8.  
Details are provided for both users and administrators.  This chapter’s major sections 
are listed below: 

• Minimum System Requirements  

• Using the SHA Workspace shows the MicroStation Manager window and 
what Workspace Options should be selected to obtain the new V8 CAD 
Standards.    

• Workspace Setup provides instructions on how to install the Workspace, 
with notes for both Internal SHA Users and External Consultant Users. 

• Workspace Options explains how MicroStation’s Workspace Options are 
being implemented at SHA, including User, Project and Interface. 

Minimum System Requirements 
The July 2004 release of the V8 CAD Standards has been designed to run on 
MicroStation V8.01.02.15.  Earlier versions may experience errors trying to run 
certain custom tools.  Please refer to Bentley documentation for product system 
requirements. 

Please note that Bentley’s latest release of V8 – MicroStation 2004 – has not been 
thoroughly tested in this workspace, though no obvious problems have yet been 
found.  Users are encouraged to migrate to MicroStation 2004 at their discretion.  As 
improvements are made to the workspace to take advantage of new software features 
(e.g. Model Annotation Scale), periodic workspace updates will be provided. 
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Using the SHA Workspace 
When you first start MicroStation using the SHA Workspace, the MicroStation 
Manager dialog box will appear with various options in the Workspace section: 

 

 

NOTE: Generally speaking, the only option that ever need be selected is that of 
User, to determine the proper CAD Standard version.  As of July 2004, the 
User workspace that should be used for new projects is “MDSHA_V8_01”.  
For notes on other User Options, refer to the Workspace Options section. 

Upon loading the MicroStation, the user will immediately know that they are in the 
SHA Workspace by the presence of the MDSHA IDS Main Menu and IDS Toolbox. 

   

The Main Menu has pulldowns that allow the user to select additional discipline-
specific menus, set drawing scale factors, and access various custom tools to assist in 
the drafting process. 
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Workspace Setup 

Internal SHA Users 
Within SHA, the V8 workspace has been implemented across the local area network.  
This ensures that all CAD workstations have access to the latest version of tools and 
settings as they are developed.  For instance, if a resource file has been updated, it 
need not be installed on each computer, but simply added to the network workspace 
for all users to receive the update. 

To setup the network workspace on a user’s machine, perform the following steps: 

1) Install MicroStation V8 

2) Copy the mslocal.cfg file from the LAN Workspace directory… 

ex: SHA HQ, use S:\CADD\Workspace\mslocal.cfg 

3) and Paste to overwrite the mslocal.cfg file on the local machine... 

typically C:\Program Files\Bentley\Program\MicroStation\config\mslocal.cfg 

This will redirect the workspace root to the network location.  Not only will resource 
files and other standard files be maintained on the network, but a directory will 
automatically be created for each user to store the following custom support files: 

• user preference (UPF) files 
• user interface (M01) files 
• function key menu (MNU) files 
• custom configuration (CFG) files 

 
Storing these files on the network promotes portability of each user’s custom settings.  
If a user moves to a new workstation or has their current workstation rebuilt, all 
settings will be retained.  Note also that this is a one-time setup.  If new standards are 
released in the future, they will automatically pass to the user. 

External Users (Consultants) 
For external consultant users, the SHA workspace is provided on the accompanying 
CD, and is also available for web download.  The workspace provides the core 
functionality of SHA’s network workspace, minus certain CAD management aspects 
(e.g. UPF files are not routed to the network).  Care has been taken to ensure that the 
installation will not disrupt corporate workspaces if it is run as delivered. 

NOTE: It is recommended that the SHA workspace be installed on the network, 
although installation on the local machine will also work. 

1) Unzip the files to a network or local directory.  
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2) Open the file “..\Workspace\startup.cfg” in a text editor. 

 

3) Redefine the _USTN_WORKSPACEROOT variable to point to the location of 
the Workspace folder as determined in step 1, then save and close the file. 

4) Create a desktop shortcut to V8. 

 

5) Right-click the shortcut and select Properties. 

  

6) When the Properties box opens, append the 
following text to the Target field (note that it begins 
with a space): 

 -wc[path]\Workspace\startup.cfg 

where [path] defines the full directory path of the 
Workspace.  

ex: -wcS:\CADD\Workspace\startup.cfg 

 

Click OK. 

You should now have a desktop shortcut that 
will launch the SHA Workspace.  Users 
should take care to always load design files 
for SHA projects through the shortcut, else the 
following workspace options will not be 
available. 
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Workspace Options 
The combination of User, Project, and Interface determines the user’s working 
environment for MicroStation.  The significance of these options is explained below. 

User 
In the SHA Workspace, choice of user determines what version of the CAD 
Standards will be delivered.  The initial release of the V8 standards provides two 
users: “MDSHA V7” and “MDSHA V8 01”.  As new CAD standards are released in 
the future, new User options will be added.  The advantage of this method is to 
maintain legacy standards for use on old projects as needed. 

MDSHA V8 01: This option delivers the new V8 CAD standards and should 
be selected for any new projects that are to be performed using the V8 design 
file format (unlimited named levels, etc).  V7 files will always be opened as 
read/only. 

 
 

MDSHA V7: Allows editing of V7 files (via the V7 Workmode) using the 
old SHA CAD Standards for MicroStation J.  This option is ideal for working 
on old projects in the old standards and viewing legacy CAD files.  Should 
NOT be used for projects in V8!!! 

 

Project 
The SHA Workspace does not rely on the Project setting to manage project design 
files and resources.  Rather, this setting is used in-house by some divisions to define 
certain discipline-specific settings and standards.  For instance, the Highway 
Information Systems Division (HISD) has their own Project setting to deliver 
additional resource files not needed by the design divisions. 
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NOTE: For most SHA users, the Project setting will be preset based on user login 
and does not need to be changed!  Possible exception may be TEDD users. 

External consultants may continue to use the Project configuration as needed to 
define specific project working directories, etc.  Note that SHA’s use of ProjectWise 
should achieve this goal in-house. 

Interface 
The choice of Interface determines what custom pull down menus and toolboxes a 
user will receive.  Within SHA, this setting will reflect the user’s NT login name, 
which will allow individual customization. 

 

NOTE: For all SHA users, the Interface setting will come up as default for first time 
use, then change to the NT login name for all future sessions! 

For the consultant workspace, the user interface variable is not explicitly defined, so 
users should continue to see the same Interface options that they normally would.   

 

 

What’s Next? 
Chapter 2 describes how to set up CAD files within MicroStation V8.  Standard and 
nonstandard file types and file naming conventions are also explained.  The chapter 
also discusses directory structures and storage spaces for SHA CAD files.  The new 
file management system ProjectWise will be introduced, with instructions on how to 
use it within MicroStation. 
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Chapter 2 
CAD Files 

This chapter explains SHA’s new file naming convention for V8 CAD files, and 
provides basic information about file management, including use of ProjectWise.  
This chapter’s two major sections are listed below: 

• File Naming Convention provides details about how to name V8 CAD files.  
Topics include explanation of the File Group character, the File Discipline 
characters, and use of the File Naming Wizard, which helps to make sense of 
the new convention. 

• File Management provides information about how CAD files are organized 
and maintained at SHA, including the use of ProjectWise as well as the 
traditional CADD directory on the S:\ drive.  Notes are also included on how 
users should deal with Legacy CAD files when making the transition to V8. 

File Naming Convention 
SHA has established a new file naming convention for use with V8 CAD files that 
follow the new standards.  It was designed to provide a flexible file-naming structure 
that can accommodate all design disciplines at SHA, while signifying at a glance that 
the files were created using the V8 CAD Standards. 

 

Key to understanding the new naming convention is recognition that all CAD files 
can be categorized according to the general function they serve.  For instance, some 
files serve solely as reference files, while others are intended for plotting.  These 
categories are henceforth referred to as File Groups. 
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File Groups 
File Group describes the general purpose that a file serves as part of the larger CAD 
production workflow.  For instance, sheets and displays are often composed of 
various design files that are referenced into the master plotted file.  The File Group 
essentially specifies whether or not a file functions as a reference file, or is in fact the 
final plotted output file. 

File Group is identified by a single-letter abbreviation which is used as the first 
character in the filename.  These File Groups are: 

P - Print Files: These files are printed to deliver the final products of SHA CAD, 
whether they are contract documents, plan sheets, profile sheets, cross-section 
sheets, schedules, brochures, or wall displays—any file to be printed directly.  

 M - Model Files: Coordinately-correct reference files which form the basis for 
site design.  These files will be referenced to final Print files (see above) and 
are often sub-categorized as Existing and Proposed. 

 D - Detail Files: Reference files that contain design details.  Not to be confused 
with the actual plotted detail sheet, which would be a (P) Print file! 

 X - Miscellaneous Files: Reference files that do not fall easily into one of the 
other categories.  This includes the Base Linen file and Layout / Motif file. 

S - DGN Support/Work Files: Files that are critical to the CAD design process, but 
are neither plotted not referenced into plan sheets. Such files may be necessary for 
use of design software (e.g. Geopak pattern and shape files) or may simply be 
used for engineering, calculations, and measurements by the designer.  

The majority of files used in creating contract documents will be either an M-model 
file or a P-print file.  An illustration of the CAD File Groups hierarchy with some 
example file types is displayed on the following page. 

File Discipline 
A file discipline describes, in the broadest sense, the discipline of information 
appearing within a particular design file. All SHA design file disciplines are 
designated with a basic two-letter file abbreviation used in the filename for 
identification.   

Examples include Topography (TO), Highway Design (HD), Landscape Design (LD), 
and Signing (SN).  A comprehensive list of file disciplines may be found in the File 
Naming Wizard.   

NOTE: For this edition of the CAD Standards, the CAD Standards Subcommittee has 
updated the list of standard File Disciplines. In most cases, the abbreviations are the 
same, though some have changed, and several new disciplines were added.  
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(X) Miscell. 
(References)

Coordinately-
correct design 
files that model 
proposed design 
features across 
the entire 
project.  

Coordinately-
correct design 
files that model 
existing features 
across the entire 
project.   

Detail drawings 
that are not 
directly printed, 
but rather, serve 
as reference files 
for the detail 
sheet. 

Files that 
represent final 
output (e.g., plan 
sheets) or other 
display sheets.   

Common CAD 
files that do not 
fall easily into 
one of the other 
categories 

Proposed Existing 

CAD File Groups 

Examples: 
Bridge details, 
drainage details, 
signal details, 
mechanical 
details, etc. 

Examples: 
Plan, Profile, and 
Cross-section 
sheets, wetland 
plates, Right-of-
Way plats, 
Construction 
drawings, and 
redlines as well as 
public display 
drawings and 
visualizations. 

Examples: 
Base linen file, 
Layout file,  
Motif file 
 

Examples: 
Topographic, 
as-built, right-
of-way, and 
utility files. 

Examples: 
Alignment files, 
hydraulics files, 
TCP phases, and 
erosions and 
sediment control 
phases. 

(P) Print Files 
Sheet/Displays 

(S) DGN 
Support 

DGN files that 
are critical to 
the CAD design 
process but are 
not plotted nor 
referenced into 
plan sheets. 

Examples: 
“Work” files, 
Scratch files, 
GEOPAK and 
InRoads files, 
Quantity 
estimating files 

(D) Details 
(References) 

(M) Models 
(References)

Reference Files 
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File Naming Summary 
The IDS Team has developed a file naming convention that incorporates both the File 
Group and File Discipline into the name. While the first 3 characters are consistent 
for all CAD files, the exact format of the remaining characters will vary based on the 
File Group.  And although filenames will be longer than 8 characters, the first 8 
characters will still be unique within a given project. 

PRINT FILES  
pDD-TZZ_Project.dgn  
Where DD = File Discipline (See Appendix G) 

T = Sheet Type (see table at right) 
ZZ = Sheet number 
Project = Route #, Bridge #, TIMS #, etc 
 
 

REFERENCE FILES 
Model (Ref) Files: mDD-AAZZ_Project.dgn 
Where DD = FileDiscipline (See Appendix G) 

AA = Alternate or version number  
(00 indicates final design)  

ZZ = ID for section of project  
(00 indicates composite file) 

Project = Route #, Bridge #, TIMS #, etc  
 

Detail (Ref) Files: dDD-SSZZ_Project.dgn 
Where DD = File Discipline (See Appendix G) 
 SS = Detail sheet number 

ZZ = Sequence number 
Project = Route #, Bridge #, TIMS #, etc  

 
Miscellaneous Files: xDD-ZZZZ_Project.dgn 
Where DD = File Discipline (See Appendix G) 

ZZZZ = Optional descriptor characters 
Project = Route #, Bridge #, TIMS #, etc  

 

DGN SUPPORT/WORK FILES 
sDD-ZZZZ_Project.dgn 
Where DD = File Discipline (See Appendix G) 

ZZZZ = Optional descriptor characters 
Project = Route #, Bridge #, TIMS #, etc  

 
• NOTE: The filename extension for all CAD files should be the default “.dgn”  
 
 

Sheet Type T
Title sheet T
Index sheet I 
Notes N
Schedules S
Plan sheet P
Section sheet X
Profile sheet V
Detail sheet   D
Redlines *R
As-Builts  A
Figure / Plate F
Wall Display W
Cartography/Mapping M
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File Naming Wizard 
In order to promote understanding of and adherence to the new file naming 
convention, a File Naming Wizard has been developed.  Access the file naming 
wizard through the IDS Tool Box in the SHA workspace.  

  

The wizard not only constructs the file name, but also creates one or multiple files in 
numbered sequence using standard seed files.  Required fields are labeled in red text: 

  

There are two methods to build a file name using the wizard: 

1. Select by Group, Discipline & Sheet Type 

2. Select by Description 

Please refer to the V8 CAD Standards Training Guide for more information. 
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File Management 
SHA has begun utilizing ProjectWise as the centralized project file management tool 
for use by both internal SHA and external consultants.  This section provides basic 
guidance on how CAD files are to be organized, stored, and accessed by all interested 
parties.  For more detailed information, please refer to ProjectWise documentation. 

Directory Structure 
SHA will use a standard Project Folder Template for all new projects in ProjectWise.  
The standard template is evolving with use.  For the most current template, please 
refer to ProjectWise. 

The Folder structure in ProjectWise was developed by the IDS Collaboration 
Subcommittee with input from both SHA and consultant project managers based on 
organizational needs and file security settings.  Though consultants are not required to 
use this structure at their office, they will ultimately be responsible for ensuring that 
project files are imported into the correct ProjectWise Folder with correct reference 
files attached.   

ProjectWise 
ProjectWise acts as a file “librarian” by maintaining all project files in a centralized 
location.  File access is controlled through file “check-in/check-out” procedures 
which guarantee that all project team members have access to the same up-to-date 
data, while at the same time preventing users from duplicating or overwriting each 
other’s work. 

Furthermore, ProjectWise allows remote access of files across the internet.  SHA 
envisions that this will become the primary method for consultants to receive and 
submit project files in the future.   

For more information about the use of ProjectWise and the project template directory 
structure, refer to the ProjectWise documentation or contact the IDS Team. 

SHA CADD Server 
In some instances, you may need to store files directly onto the SHACADD server.  
The path of the CADD server is S:\CADD\.. and is organized by division and district.   

When organizing project files, keep the following guidelines in mind: 

• Keep all design files belonging to one project together in the proper folder. 
They can be referenced easily if they are together. They may become 
disconnected reference files if they are not kept in the same folder. Do not 
modify files in any other way. 

• Update reference files regularly to ensure the most current versions of all 
design files. Check the file folder on the server to see if any newer versions 

mailto:ids@sha.state.md.us?subject=ProjectWise
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exist. Also, keep updated versions of your files on the server so that others can 
update your files as their reference files. 

Legacy CAD Files 
Not all design files will be created from scratch.  In addition to files accumulated, 
shared, and managed through ProjectWise, engineers may receive files from 
consultants or from other SHA Divisions.  Unless instructed otherwise, do not 
change any file names.  

Refer to the section in the appendix, “Converting V7 Files to V8” for more 
information on (1) whether or not to convert a project to V8 standards, and (2) if so, 
how to properly perform the conversion. 

 

 

What’s Next? 
Chapter 3 provides specific details about SHA’s standard settings and symbology 
elements, including standard seed files, color table, level names, fonts, etc.  
Information is provided about the use of new aspects of V8 (level libraries, level 
filters, text styles, DGN library) as well as a new CAD drafting technique that has 
been implemented: Drawing Scale. 

 



SHA CAD Standards 2-8 July 2004 

Notes � 



SHA CAD Standards 3-1 July 2004 

Chapter 3 
Design Standards 

This chapter provides specific details about SHA’s standard settings and symbology 
elements, including standard seed files, color table, level names, fonts, etc.  This 
chapter’s major sections are listed below: 

• Seed Files lists SHA’s standard seed files for use with V8 

• Standard Settings provides details about the settings contained in the 
standard seed files.  This includes notes about Working Units, Survey Feet, 
Coordinate Readout, Drawing Scale (NEW!), Color Table, and DGN 
Libraries. 

• Standard Elements provides information about the feature symbology that 
has been developed for the V8 standards, including level names, line weights, 
line styles, and text styles.   

• Custom Tools provides as overview of some of the applications that have 
been developed as part of the IDS effort that are included in the workspace. 

Seed Files 
To ensure design file setup consistency, the following standard seed files have been 
created. These seeds should always be used as a basis for developing any new files, 
including cell libraries.   

Seed File Name Description 
shaModelSeed2D.dgn Standard 2D model 
shaModelSeed3D.dgn Standard 3D model 

 
The following seed file has been developed for the Office of Bridge Development to 
create detail sheets in MicroStation 2004 (and in fact may be used for any detail 
design). 

Seed File Name Description 
shaDetailSeed2D.dgn Self-referenced 2D models at different scales 

 
The seed consists of multiple V8 Models that are self-referenced at different scales to 
facilitate the creation of multiple details at different scales within the same file. (For 
more information on working with Multiple Models, refer to the V8 CAD Standards 
Training Guide in the Documentation directory of the Workspace.) 
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Standard Settings 

Working Units 
All new V8 design files created for use on an SHA project shall conform to the 
following settings, which are incorporated in the seed files (unless otherwise noted): 

Global Origin (2D): 0, 0 
Global Origin (3D): 0, 0, 0 
Master Unit (Label): Survey Feet (’) 
Sub Unit (Label): Survey Inch (”) 
 

 
 
Resolution:   1000 per Survey Foot 
Solids Working Area: >375 Miles 
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Notes on V8 Working Units/Resolution 

The MicroStation V8 file format represents a major change in the way that coordinate 
data is stored.  The 32-bit integer-based design plane has been replaced by a double 
precision floating point coordinate system.  This has the following practical effects: 

1. The V8 design plane is essentially infinite. 

2. Positional accuracy in terms of master units is essentially unaffected by 
unit setup  

Whereas in V7, design files representing Maryland’s coordinate grid were required to 
have resolution of 1000 position units per master unit, this is no longer the case.  
Units of resolution have been retained in the design file primarily as a means of 
maintaining compatibility with the V7 file formats.  What’s more, the floating point 
coordinate system has the following effect: 

3. Unlike Pre-V8 MicroStation, changing the working units does not affect 
the size of elements.   

In V7, if you were to draw an element measuring 10 ft, then changed the working 
units from feet to meters, the element would measure 10 m long.  Now with V8, the 
same change from feet to meters would result in an element measuring 3.048 m. 

While this is an important operational improvement, it has significant consequences 
for that way that SHA must set up their design files.   

International Feet vs. US Survey Feet 

By default, a “Foot” in MicroStation actually refers to an International Foot.  
However, the state plane coordinate system upon which all SHA roadway design jobs 
are based is measured in US Survey Feet.   

International Feet: 1 foot = 0.3048000 m 

US Survey Feet: 1 foot = 1200/3937 m ≈ 0.3048006 m 

The workspace contains a custom units definition file, units.def, that defines survey 
feet and controls the conversion of V7 files to V8. 
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Coordinate Readout 
The following coordinate readout settings are delivered in the standard seed files: 

 Models (2D/3D) Details   
Coordinates Format: Master Units Working Units 
Coordinates Accuracy: 0.1234 1/64 
Angles Format: DD.DDDD DD.DDDD 
Angles Mode: Conventional  Conventional 
Angles Accuracy: 0.1234 0.1234 
 
 

Drawing Scale 
One of the key features of the new CAD Standards is the use of a drawing scale, 
which is displayed along the top of the MicroStation window.  (If it does not appear 
in your window, select Scale > Display Current Scale from the Main Menu.) 

 

Drawing scale may be changed by selecting the appropriate scale factor from the 
Main Menu pulldown.  The scale factor is stored with the file. 

 

All scale-dependent drawing elements – i.e. text, cells, & linestyles – have been 
defined in the new CAD Standards at a unit (1:1) scale.  The element is then scaled up 
or down by the drawing scale factor when it is selected from a barmenu.  This helps 
maintain consistency of scale-dependent drawing features, regardless of the scale 
being used.   
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Programming Note: Before processing any scaling commands, the SHA Workspace 
checks what version of MicroStation is being used (V8.1 or 2004).  If it is V8.1, the 
active Line Style Scale Factor is used as the default drawing scale.  If it is 2004 or 
later, the Model Annotation Scale of the active model is used as the default drawing 
scale.  The same Main Menu > Scale > pulldown sets the scale factor for both 

  

This is a new feature in MS 2004, and has the advantage of being applied at the 
Model level (as opposed to the linestyle scale factor, which is applied across all 
models in a file.) 
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Color Table 
The standard color table for all SHA design projects is ClorMdSha.tbl.  This color 
table defines the RGB values for the MicroStation colors 0-255.  The monochromatic 
(black & white) pen tables have been set up for use with this table such that all colors 
plot as black, with the exception of those color values defined below. 

232 Gray 10% 
233 Gray 20% 
234 Gray 30% - Shading 
235 Gray 40% 
236 Gray 50% - Linework 
237 Gray 60% 
238 Gray 70% 

Gray 
Scale 

239 Gray 80% 
240 SHA Logo Orange
241 SHA Logo Blue 
242 Orange 
243 Yellow 
244 Blue 
246 Green Shading 
247 Green Lines 
252 Red Shading 
253 Red Lines 

True 
Color 

254 White to block items out
 

Refer to the chapter on Plotting for more details. 

 

DGN Library 
One of the major new changes to V8 is the use of DGN Library files (DGNLIBS) to 
maintain and deliver CAD Standards. Such standards can include the following: 

• Levels 
• Level Filters 
• Text Styles 
• Dimension Styles 
• Cells 

 
The DGNLIB provides these standard items to the user, but locks them from being 
edited, thus helping to maintain Standards.  At this time, only level filters are being 
maintained in SHA’s standard DGNLIB. All other standard elements are delivered in 
some other fashion.  Please refer to the relevant sections below for more information.  
Once the new CAD Standards mature through testing and use, more of the above 
items will likely be put into DGNLIBS. 
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Standard Elements 
This section describes MicroStation features and the related CAD Standards that must 
be followed to maintain consistency across all design files.  

Features 
A feature corresponds in a very specific manner to a single type of design information 
contained within a file type.  A feature defines not only a specific piece of 
information, but also how it is to appear within the design file.  A single file type may 
contain hundreds of features, each with its own unique set of graphical parameters. 

The IDS Team has completed a comprehensive survey of all features in use by SHA. 
These features are maintained in the IDSIM database, along with all primary 
attributes (level, color, weight, and style) and secondary attributes (including text 
size, font, etc).  The feature definitions are maintained by division CAD reps.  

The most important parameters assigned to a feature are level, color, weight, and 
style.  Many other parameters, such as text font, text size, and so on may be defined 
for a particular feature, but these extra parameters are not necessarily used for 
identification purposes. By definition, two elements belong to the same feature 
whenever they have the same cell name or level, color, weight, and style, even if 
other parameters may be different. 

Barmenus 
As a general rule the barmenus are used to find the standard symbology (level, color, 
style, and weight) for any item that is contained in the file.  If you need an item and 
can’t find it in the barmenus or Feature Search tool, contact your CAD manager, or 
email IDS@sha.state.md.us.  A new feature might need to be added.  

Main Menu 

Upon entering the SHA workspace, the Main Menu will appear, along with the IDS 
Toolbox.  The Main Menu contains key pulldown commands that are applicable to 
any file in the workspace. 

 

 

NOTE: The Main Menu should always remain loaded.  If it has been unloaded or is 
not visible, select the SHA icon from the IDS Toolbox to reload, or key-in “mdl load 
shabarmenu”. 

 

mailto:IDS@sha.state.md.us
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• The Menus pulldown contains links to discipline-specific menus: 

 

 

Selecting one of the items from the Menus pulldown does 
the following: 

1) Unloads the current discipline-specific menu 

2) Unloads the attached level libraries 

3) Loads the selected discipline-specific menu 

4) Loads the appropriate level libraries. 

5)  

 

 

• The Scale pulldown contains commands that allow you to set the file’s drawing 
scale.  Typically this is done once, at the time the file is first created.  The active 
scale will be displayed along the top of the MicroStation window. 

 

 

MicroStation V8.1 – This version 
uses the Linestyle Scale Factor as the 
de facto drawing scale 

MicroStation 2004 – This version 
uses the Model Annotation Scale as 
the de facto drawing scale. 

NOTE – when first opening a file in 
2004, it may be necessary to reset the 
drawing scale and the Text Styles 
(Tools > Import SHA Text Styles) if 
the file was originally created using 
V8.1 
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• The Tools pulldown contains links to various drafting tools, both custom 
developed and MicroStation delivered. 

 

• The Help pulldown contains links to the CAD Manual, as well as information 
about the current version of the Workspace. 

 

Discipline/File Specific Menus 

Many additional barmenus have been created based on file discipline (e.g. Roadway 
Design, Drainage Design, etc) or general file type (e.g. Plan Sheet, Title Sheet).  
When a file is first opened, the workspace checks the file name to see if it follows the 
standard file naming convention.  If there is a match, the appropriate barmenu will be 
automatically loaded, along with any associated level libraries.  As noted above, these 
barmenus may also be called from the Main Menu. 
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Levels 
Levels are named slots for graphical elements in a file whose display can be turned on 
or off.  This allows users to have lots of information saved in one file, even if the 
material does not all need to be used or viewed at the same time.  MicroStation V8 
allows you to define an unlimited number of named levels. 

Level Names 

SHA’s V8 level naming convention is based on the guidelines set forth by the 
National CAD Standards, with changes as needed to accommodate a civil 
transportation workflow: 

MAJR-MINR-SUBM 

Where:       MAJR = 4-character Major Group 
        MINR = 4-character Minor Group 
       SUBM = 4-character Sub-Minor Group 

Examples: 

 

Level Library for Topographic File 
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Level Libraries 

Level names are managed by attaching level libraries.  When a barmenu is selected, 
the appropriate level library is attached.  The library remains attached if you close and 
reopen the file.  Note that when level libraries are detached, or if the file is opened 
outside of the standard SHA workspace, used levels will still appear while unused 
levels will not. 
 
Level libraries have the ability to define level names and descriptions and also the By 
Level Symbology and Override Symbology for each level.  (Note that By Level 
symbology has not been adopted in these Standards).  All these attributes are 
currently maintained for each level library in the IDSIM database, which can then 
generate the actual level library files in CSV format.  Therefore if a level name needs 
to be modified, all level libraries using that level can be quickly regenerated. 
 
It is important to mention that levels are currently not enforced via DGN Libraries.  
For the initial rollout of V8 it was deemed simpler to create individual level libraries 
for each file and attach them each as needed with the appropriate Barmenu.  Users 
also have the option to create new levels as needed, and are encouraged to forward 
needs and suggestions to ids@sha.state.md.us.  

Level Filters 

Level filters serve two purposes:  (1) to limit the number of levels that appear in a 
level list, and (2) to turn groups of levels on and off when needed.  The latter 
application is especially useful for controlling level display of attached reference 
files. 

A standard set of level filters has been 
created based on the set of new level 
names.  These standard filters are 
maintained in the levelfilters.dgnlib file.  
User may create their own filters that are 
either temporary or stored in the DGN file 
(through the level manager).  Refer to the 
V8 CAD Standards Training Manual in 
the Workspace/Documentation/ directory 
for more information. 

mailto:ids@sha.state.md.us
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Line Weights 
In previous versions of the standards, plotted line thicknesses were never formally 
defined.  As a result, plots tended to have slightly different appearance depending on 
which plotter was used, plotting software, driver, pen table, etc. The new V8 CAD 
Standards attempts to correct this oversight by assigning plotted line thicknesses to 
MicroStation weights 0-15 in accordance with industry standard drafting pens. 

 

 

 

 

 

 

 

 

 

 
Standard pen tables for Iplot and PLT files for MicroStation plotting with the above 
line thicknesses defined are delivered in the Workspace.  (Refer to the Plotting 
chapter for more details.)  In reality, most standard drafting can and should be 
accomplished using line weights 0-6, as the weights above 6 become extremely thick.   

Thin Lines (wt = 0).  Thin lines should be used for depicting background object 
lines,  centerlines, hidden lines, and most patterning symbols. 

Medium Lines (wt = 1).  Medium lines should be used for depicting dimension 
leaders/witness lines, dimension lines, dimension text, text for notes/callouts, 
schedule boxes/charts, text inside schedules, minor object lines, line terminators 
(arrowheads, dots, and slashes), and note leader lines. 

Medium Thick Lines (wt = 2,3).  Medium thick lines are the default line weight for 
drawing most objects.  Medium thick lines should also be used for section titles. 

Thick Lines (wt = 4).  Thick lines should be used for minor title underlining, text for 
titles, and object lines requiring special emphasis. 

Extra Thick Lines (wt = 6).  Extra thick lines should be used sparingly.  Extra thick 
widths are appropriate for use as elevation grade lines, building footprints, or top of 
grade lines on section/foundation details. 

MicroStation
Weight 

Full Size 
Thickness (mm) 

Koh-i-nor 
Pen Size 

Half Size 
Thickness (mm) 

wt = 0 0.18 0000 0.09 
wt = 1 0.25 000 0.125 
wt = 2 0.30 00 0.15 
wt = 3 0.35 0 0.175 
wt = 4 0.50 1 0.25 
wt = 5 0.60 2 0.30 
wt = 6 0.70 2.5 0.35 
wt = 7 0.80 3 0.40 
wt = 8 1.00 3.5 0.50 
wt = 9 1.20 4 0.60 

wt = 10 1.40 5 0.70 
wt = 11 1.70 6 0.85 
wt = 12 2.50 8 1.25 
wt = 13 3.80 10 1.90 
wt = 14 5.00 12 2.50 
wt = 15 6.35 14 3.175 
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Line Styles 
The fundamental change in the approach to working with line styles has been to 
“unitize” the size of those styles that should be scale-dependent.  This includes such 
styles as the Woods Line, and any style that contains text.  When these styles are used 
in a drawing, they must be scaled up or down according to the drawing scale (e.g., 
times 50 for 50-scale).   
 
This appropriate scale factor is applied automatically when these styles are selected 
from a barmenu.  However, if they are selected through the usual active attribute 
interface, they may appear incorrect in the drawing because of an improperly set scale 
or an on/off toggle that was pressed accidentally.  When this happens, use the 
commands under the Main Menu to apply or remove the scale factor setting. (Main > 
Scale > Drawing Scale ON, and so on.)  

Cells 
One of the key changes to use of cells in V8 is the ability to place cells at True Scale.  
This means that if a cell was drawn to be 1 foot wide, if placed in a metric drawing it 
would measure 0.3048 m.  Similarly, V8 will rectify the size of cells drawn in files 
with different units of resolution.  

All of SHA’s standard V8 cells have been 
created with units of resolution to match the 
standard seed files (meaning that they will 
always be true scale).  Nevertheless, it is still 
recommended that users keep the True Scale 
checkbox turned on at all times just in case. 

 

As with the linestyles, note that most symbol-type cells (i.e. scale-dependent) have 
been created at a unit size for easy placement.  For these cells, the active scale should 
be set to match the drawing scale (i.e. 1”=50’).  When selected from one of the 
barmenus, the correct active scale will be applied automatically. 

   



SHA CAD Standards 3-14 July 2004 

Fonts 
The 95 CAD Standards had a single resource file (shafonts.rsc) that contained all 
fonts.  This library has been broken down into several smaller libraries for 
manageability.  In order to maintain compatibility will legacy CAD files, all fonts 
from the 95 standards have been preserved in the file sha_font_legacy.rsc.   

However, in order to achieve more consistent plan sets, the following standard fonts 
are recommended for use: 

1 – Working:   Proportional font 

10/43 – Leroy: Filled font 

3 – Engineering:  Monospaced font 

42 – font042:  Block font 

2 – Fancy:   Serifed font 

Use of these fonts is being encouraged through their implementation as Text Styles.  

     

Text Styles 
MicroStation V8 has introduced a new feature to facilitate the placement of text – 
Text Styles.  Standard text styles can be created which preset font, text height, text 
width, etc., for quick and easy placement.  The SHA Workspace takes advantage of 
Text Styles in the following ways: 

One of the primary advantages of Text Styles, aside from maintaining consistent 
appearance of text, is the ability to propagate the drawing scale to the size of the text.  
So long as the Drawing Scale has been properly set from the Main Menu, the size of 
the text will match.  In MicroStation 2004, this is achieved by enabling the Model 
Annotation Scale Lock. 

• Sample text styles have been placed in the seed files.  Note that these are 
currently not locked for editing by a DGNLIB file. 

• Text Styles are automatically scaled by the active Drawing Scale, as 
follows: 
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� MS V8.1 – changing the drawing scale via the Main barmenu 
triggers a macro that scales the text size of all text styles in the 
file by an appropriate factor. 

� MS 2004 – text styles are maintained at unit size (1”=1’), but 
will be scaled at the time of placement if the Model Annotation 
Scale Lock is enabled. 

 

NOTE:  In V8.1, if a user changes the drawing scale of a file that already contains 
text, the macro will break the association of the text with the text style used to create 
it.  However, this will not change the appearance of text.   

In 2004, the user will be asked if the drawing scale should be applied to existing 
text… the recommended response is NO. 

Importing Standard Text Styles 

If a file was not created based on a standard seed file, it will not contain proper text 
style definitions.  (This is common for files converted to V8 from an earlier version.) 
Similarly, if a file was begun in V8.1 and later worked on in 2004, there will likely be 
a disconnect with text size (owing to use of the Model Annotation Scale Factor). 

To address both of these issues, a command has been added to the Main Menu that 
will import the standard SHA text styles, scaling them as appropriate.  (Main > IDS 
Toolbox > Import SHA Textstyles)  Be careful, however, because this action will 
delete any custom text styles you may have created. 

Dimension Styles 
Dimension Styles are another new item to the SHA Standards.  Several sample styles 
have been created for use: Architectural, Structural, Civil, Detail, and Survey.  These 
styles are currently maintained in the seed file rather than the DGNLIB so as not to 
lock them from editing in case a user needs to change a terminator or the number of 
decimal places.  As with the Text Styles, missing Dimension Styles may be imported 
to a file from the Main Menu (Main > IDS Toolbox > Import SHA Dimension 
Styles).  Once these styles have been refined through use, they may be added to the 
DGNLIB file. 
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Custom Tools 
This section describes the custom applications and tools available through the SHA 
Workspace.  Some were created in-house or through consultants.  All are intended to 
simplify, standardize, and make the creation of CAD drawings more efficient. 

IDS Toolbox 
IDS Toolbox is a collection of MicroStation V8 tools that have been developed for 
SHA.  This toolbox is automatically loaded by the workspace.  If it is unloaded or not 
visible, select Tools > IDS Toolbox from the Main Menu, or key-in “mdl load idstb” 

 

Feature Search Tool 
The FEATURE SEARCH tool is an interface developed to help browse the CAD 
Standards for unknown symbology settings. 

 

File Naming Wizard 
The FILE NAMING WIZARD helps users create files using the new file naming 
convention.  Refer to the “File Naming Convention” section of this chapter for more 
information.  Activate the File Naming Wizard from the IDS Toolbox. 
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Drainage Tools 
DRAINAGE TOOLS is a Tool Box containing multiple commands used for placing 
storm drain items, including inlets, pipes, manholes, end walls, and end sections. 

 

Grid Tick Placement Tool 
The GRID TICK PLACEMENT TOOL assists the user in placing grid ticks on plan sheets.  
By default, the grid ticks are locked to a grid interval of 250 ft.  Place from one to 
three grid ticks.  Size of the tick is automatically scaled according to the file’s 
drawing scale. 

  

MCPC 
MCPC is a longstanding SHA application developed for the Plats & Surveys Division 
to assist in the development of property lines and plats.  MCPC requires an InRoads 
license in order to operate. 

  

NOTE: The version of MCPC included on the CD will only run on MicroStation 
V8.1 with InRoads V8.4.  A recompiled version for MicroStation 2004 will 
be available in the summer of 2004.  Check  
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TEDD Apps 
TEDDAPPS contains a series of commands developed for the Office of 
Traffic & Safety’s Traffic Engineering Design Division to assist in the 
development of their construction documents. 

 

gINT Borlog 
The GINT (GEOTECHNICAL INTEGRATOR) BORLOG TOOL is a productivity tool 
developed by IDS for the purpose of placing soils information into Contract Plans.  

 

gINT is a database containing soils information that is maintained by the Geotechnical 
Explorations Division of SHA’s Office of Material and Technology.  gINT Borlog 
reads soils information contained in a gINT file and generates soil profiles and soils 
test data tables, which may then be placed onto the Profile Sheets of Contract Plans.   

 

 

What’s Next? 
Chapter 4 provides basic drafting guidelines.  Some of the information is specific to 
use of MicroStation V8, while other information is more universal.  It is hoped that 
the information contained in the chapter will prove helpful to drafters both new and 
old. 
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Notes � 
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Chapter 4 
Drafting Guidelines 

This chapter provides discussion and information about various drafting guidelines 
and procedures when composing contract documents.  This chapter’s major sections 
are listed below: 

• SHA Border File discusses use of the standard D-size border file developed 
for creation of contract documents at SHA. 

• Reference Files contains basic information about attaching reference files in 
MicroStation V8, providing recommendations for using the new settings. 

• Text Placement: Model vs. Print Files discusses the proper placement of 
text in design files. 

• Addenda Procedures contains basic workflow information about the 
creation of addenda. 

• Redline Revision Procedures contains basic workflow information about 
the creation of redline drawings. 

SHA Border File 
In order to promote title block integration with ProjectWise, a single border file has 
been developed for all disciplines across SHA.  This file is located in the Workspace/ 
Standards/MDSHA_V8_01/dgn/Borders/ directory and is named xBL-BORDER.dgn 

The border file has individual saved views created to deliver discipline-specific 
settings.  When the border file is attached to the plan sheet as a reference file, the 
appropriate saved view should be selected.  The borders and standard sheets provided 
in the workspace are drawn to the conventional 1" = 1' scale and should be scaled up 
or down accordingly when attached.  Please refer to the V8 CAD Standards 
Training Guide for more information. 
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Reference Files 
Many interface changes have been made to the way in which reference files are 
attached.  The following recommendations are provided to help you understand the 
new settings. 

Save Relative Path  
SHA recommends all users enable this check box, as it is assists with ProjectWise 
integration.  It remembers the directory location of the reference file relative to the 
directory of the active file, thereby promoting portability of the project working 
directory.  This setting will not interfere with the MS_RFDIR variable. 

 

Note that this setting has essentially replaced the Save Full Path option of earlier 
versions, which is no longer an option.  Rather, MicroStation V8 searches for 
reference file attachments in the following manner: 

1. active directory 

2. relative path directory 

3. MS_RFDIR directory 

4. full path directory 

 

Coincident-World 
This setting adjusts reference files with 
different Global Origins.  The Workspace is 
set up by default to attach coincident-world 
orientation.  It is recommended that this 
option always be enabled. 
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True Scale 
This setting adjusts reference files with 
different Units of Resolution.  As with 
Coincident-World, it is recommended that this 
option always be enabled. 

 

 

 

 

 

3D and 2D Design Files 
MicroStation V8 now allows 3D files to be referenced into 2D files!  This means that 
under no circumstances should topo files, grading files, or other 3D files be 
“squashed” to 2D to accommodate referencing into a 2D plan sheet.   

Such practice, while common to the V7 workflow, creates the undesirable issue of 
having multiple versions of the same file in production.  If the information in the file 
needs to change, there is small likelihood that the changes will be made uniformly to 
both.  Sooner or later, confusion arises as to which copy of the file reflects the most 
up-to-date information. 

Repeat: there is no longer a good reason to convert 3D files to 2D.  Don’t do it!  If 
need be, set your active depth to zero and activate the Depth Lock. 

Text Placement: Model vs. Print Files 
Annotation text belongs in the Print file whenever possible.  However there are 
instances when text must be placed in the Model file.  This usually occurs for items 
that can be annotated across the entire job, (usually with InRoads or GEOPAK), such 
as topo text or alignment stationing.   

The advantage of placing text items in the Model file is that as the design is refined, 
the changes can be made globally to the entire project.  The disadvantage is that text 
in a given Model file often overlaps with text in another Model file, both of which are 
referenced into the same plan sheet.  When this occurs, the recommended workflow is 
to resolve the text conflict in the Print file, NOT in the Model file.  As follows: 

1. Identify the text item that is least likely to change (e.g. topo text labels) 

2. Copy all the text from the level on which the conflicting text is located into 
the Print file (i.e. plan sheet) 
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3. Turn off the Model file level containing the conflicting text. 

4. Resolve the text conflict in the Print file. 

Note that all text in a given model file should be at the same scale.  50’=1” is used for 
most projects, and topo is generated at that scale unless a specific request is made in 
advance.   

It sometimes occurs that a designer requires the same annotation for different scales 
(e.g. geometry sheet stationing, wetland plates).  Given the ability in MicroStation 
2004 to set the Annotation Scale at the model level, designers are encouraged to 
create a separate model within the same DGN file that is reserved solely for the text at 
the alternate scale.   

Addenda Procedures 
Addenda are changes that are made to contract documents after their official 
publication.  Addenda at SHA are typically for contract plans; however, the same 
concept may also apply to various other published files such wetland permit plates, 
public brochures etc., where changes must be tracked for customers reviewing the 
documents. 

Addenda for Contract Documents 
In the case of contract plans and specifications, these are typically changes that are to 
be published after the advertisement of the project.  All changes in this phase of the 
files must be tracked.  Drawing elements may be modified, deleted, or added to the 
files, but each edit must be marked with the addenda symbol using the proper number 
of the Addendum.  This includes changes that may have been cosmetic only.  The 
sheet Border file revision box must also note the Addendum Symbol with proper 
number, and the date the addendum is to be published.  This date will be provided by 
the Project Manager.  For example: 

 

 

 

 

 

 

Changes to the plan sheet must be described, per sheet, in the documentation that will 
be accompanying the published plans.  The accompanying documentation should 
have a clear description of all changes that are on each sheet.  For example:  
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Sheet No. Description 
 
13 EXTENDED limits of concrete paving section on MD 43 to Station 535+50+. 
 
 CHANGED “Existing MD 43 Mainline Partial-Depth Patching” detail to “Existing 

MD 43 Mainline Full-Depth Composite Patching”. 
 
 CHANGED “Modified Type ‘A’ Curb & Gutter” to “Modified Type ‘A’ 

Combination Curb & Gutter”. 
 
 DELETED vertical line between the curb and gutter in the “Modified Type ‘A’ 

Combination Curb & Gutter” detail. 
 

  16 ADDED bearings on BGE Access Road Table between stations 4+98.94 and 
5+29.22; 8+67.58 and 9+81.67; 18+47.89 and 19+04.18; 22+75.68 and 23+16.38. 

 

NOTE: CAD Changes that affect Project Pay Quantities must also be 
documented as changes to the Schedule of Prices. 

Pen and Ink Changes 

Addenda may also include “Pen and Ink changes” These changes are typically minor 
where SHA directs the contractors to modify the plans using their own pen and ink. 
These changes should also be made to the CAD Files, however SHA is not 
providing a revised hard copy plan sheet for the change.  These changes are typically 
directed as noted in this example: 

Note: The Attention of Prospective Bidders Is Directed To The Following Pen And Ink Change.  The 
Contractor Is Directed To The Make The Following Pen And Ink Change To The Contract Document.  
Corrected sheets will not be provided. 

 
Sheet No.  Description 
 

2 Change Sheet Numbers 660, 661, and 664 to 773, 774, and 777 
respectively. 

 
Renumber plan sheet 660 of 664 to 773 of 777. 

 
661 Renumber plan sheet 661 of 664 to 774 of 777. 
 
  Renumber plan sheet 664 of 664 to 777 of 777. 

 

Redline Revision Procedures 
Redlining refers to making changes to bid documents that have been created in the 
design phase. Once these drawings have been through bid opening, redlining begins. 
Almost always, a construction project encounters unforeseen building issues. The 
redlining process makes these changes formally and in writing.  
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NOTE: As of this writing, recommended redlining procedures are not available.   
This section will be updated in the coming months. 

 

 

 
 

 

 

 

 

 

What’s Next? 
Chapter 5 provides information about standard plotting techniques. SHA has defined 
standard thicknesses for plotted line weights, as well as stroke lengths for standard 
line styles 1-7.  The chapter provides information about the base pen tables and plot 
drivers included in the workspace to help generate uniform plots regardless of the 
plotting software used. 
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Notes � 
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Chapter 5 
Plotting 

One of the primary goals of the CAD Standards effort is to enable the creation of 
uniform plots sets.  It often happens that plots can not be reproduced from a set of 
CAD files, only because the current owner is unaware of how the original plots were 
created, or does not have access to the pen tables/plot drivers that were used. 

This chapter describes the plotting procedures to be used at SHA.  Plotting refers to 
using a printer or large-format plotter to print hard copy on paper from CAD 
drawings.  Plots can be created with either I-PLOT or Standard MicroStation plotting. 
Resources provided in the V8 Standards for both methods are described in this 
chapter. I-PLOT is commonly used at SHA, but most consultants do not use it.  In 
order to provide a Standard for baseline plotting, plot drivers were created for 
standard MicroStation plotting, including both mono and full-color plans. 

This chapter has five sections, as listed below: 

• Plotting Standards formalizes the plotting weights and line styles that should 
be used when producing SHA plans from CAD files. 

• Using I-Plot details proper use of I-Plot, including: using pen tables, how to 
work with I-plot organizer, modify plot layouts, set Display parameters, attach 
IPARM files, and submit a plot job. 

• Standard MicroStation Plotting covers pen tables, identifying the plotting 
area, verifying the plotter, setting the scale, and more. 

• Using the I-Plot Monochrome Raster Offline Driver details how to use 
SHA’s in-house driver to generate full-size black-and-white TIF images that 
look just like plan sheets. 

• Generating Images describes some methods for generating image files from 
MicroStation. 
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Plotting Standards 
SHA is attempting for the first time to standardize plotting characteristics for contract 
documents.  These parameters include the plotted line thickness (in inches) for 
standard MicroStation weights 0-15, and the stroke lengths (in inches) for standard 
MicroStation line styles 1-7.  The goal is to establish a baseline by which any plots 
can be duplicated using any plotting method.  The standard plot drivers and IPLOT 
pen tables included in the Workspace should serve as a basis for achieving this result. 

Large-format Plotters:  A roll-feed machine (typically 36-inch rolls) for the 
production of larger drawings could be inkjet or thermal.  These print a standard-size 
34 x 22-inch sheet from MicroStation for all construction documents and plans.  
Other sizes are used for large wall-display boards. 
 

IPLOT pen table MicroStation plot driver 
B/W FullMono.pen FullMono.plt 
Color FullColor.pen FullColor.plt 

 

Standard-format LaserJet and Inkjet Printers:  Half-size plans are often required 
(17 x 11-inch, tabloid).  This is also used in the production of plats, smaller drawings, 
and related documents.  

 IPLOT pen table MicroStation plot driver 
B/W HalfMono.pen HalfMono.plt 
Color HalfColor.pen HalfColor.plt 

 
 

Line Widths 
Aside from the new level names, one of the biggest differences in SHA’s new V8 
CAD Standards is the establishment of plotted line thicknesses.  In the past, the line 
thicknesses that appeared on plots were often at the mercy of the plotter.  SHA has 
attempted to correct this by hard coding the plotted line thicknesses into the new 
MicroStation plot drivers and IPLOT pen tables. Line weights 0-12 have been re-
defined to correspond with the thicknesses of traditional drafting pens, as follows: 
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Color Table 
The standard color table for all SHA design projects is ClorMdSha.tbl.  This color 
table defines the RGB values for the MicroStation colors 0-255.  The monochromatic 
(black & white) pen tables have been set up for use with this table such that all colors 
plot as black, with the exception of those color values defined below. 

232 Gray 10% 
233 Gray 20% 
234 Gray 30% - Shading 
235 Gray 40% 
236 Gray 50% - Linework 
237 Gray 60% 
238 Gray 70% 

Gray 
Scale 

239 Gray 80% 
240 SHA Logo Orange
241 SHA Logo Blue 
242 Orange 
243 Yellow 
244 Blue 
246 Green Shading 
247 Green Lines 
252 Red Shading 
253 Red Lines 

True 
Color 

254 White to block items out
 

MicroStation 
Weight 

Full Size 
Thickness (mm) 

Koh-i-nor 
Pen Size 

Half Size 
Thickness (mm) 

wt = 0 0.18 0000 0.09 
wt = 1 0.25 000 0.125 
wt = 2 0.30 00 0.15 
wt = 3 0.35 0 0.175 
wt = 4 0.50 1 0.25 
wt = 5 0.60 2 0.30 
wt = 6 0.70 2.5 0.35 
wt = 7 0.80 3 0.40 
wt = 8 1.00 3.5 0.50 
wt = 9 1.20 4 0.60 
wt = 10 1.40 5 0.70 
wt = 11 1.70 6 0.85 
wt = 12 2.50 8 1.25 
wt = 13 3.80 10 1.90 
wt = 14 5.00 12 2.50 
wt = 15 6.35 14 3.175 
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Using IPLOT 

Creating Plots using IPLOT Organizer 
This section explains how to take advantage of IPLOT Organizer to batch plot 
selected IPLOT metafiles (.i) without going through MicroStation.  It will maintain 
the consistent look and feel for the plots regardless of where you are once you are in 
ProjectWise. 

1. Login to ProjectWise with you login and Password as shown below: (Replace 
with your login name and password) 

 

 
 

2. Navigate to Project Documents > Contract Plans > SHA_IPLOT_Submittal. 
 

 
 

3. Open PlotSet, which is IPLOT Organizer data file (.ips), to view the IPLOT 
metafiles created and stored within this set shown below: 
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4. It is OK to see the messages “….dgn file was not found” because the master files 
may not be COPIED OUT. 

 
5. Navigate ProjectWise folder structure to the folder, which contains the master 

design files.  For example, the folder for this plot is “Roadway Design”. 
 

6. Select the MASTER Files using <Control> or <Shift> while selecting the files. 
 

7. Right click and choose “Copy Out” 
 

8. To verify the result, right-click an IPLOT metafile (.i) and choose Preview. 
 

9. To plot the IPLOT metafiles, right-click the file and choose Plot… 
 

10. The Print dialog box opens: 
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11. Confirm the Printer Name and click OK to continue 
 

12. The plot files will be sent with message shown as follows: 
 

 
 

NOTE: If the line style or fonts are not correct, right-click the IPLOT metafile (.i) 
and select Properties dialog box to verify the Workspace Name.  The 
Workspace, color table, and pen table can be automatically set with 
IPLOT. 
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Standard MicroStation Plotting 
There are three steps to generating prints or plots of your drawings using 
MicroStation’s standard plotting capabilities: 

• Identify the portion of the design file to be plotted. 

• Select the appropriate plotting device. 

• Transmit the drawing to the plotter. 

Identify Plotting Area: 
The area you wish to plot can be identified by one of two methods: Plot by View, or 
Plot by Fence, the most common. Follow these steps to identify your plot area: 

1. Place a fence, or arrange within a view, the portion of the drawing you wish to 
plot. If you need to plot to a scale, you must place a fence around the sheet border. 

2. Start the plot process by keying in PLOT or PRINT in the key-in window. 
Alternatively, you may press the accelerator key CTRL, + the P key. 
Alternatively, you may select the Print/Plot command from the File pull-down 
menu. 

3. Examine the status line on the Plot dialog box to ensure that “Fence (View n)” 
displays if you intend to plot contents within a fence you’d placed earlier. 
Otherwise, it will display “View n”. 

Plot Drivers 
Plot drivers determine how the MicroStation elements are translated to the printer, 
including exact colors and the thickness of various line weights. After identifying the 
plotting area, you need to select a plotter driver. The following drivers are delivered 
in the V8 Standards for various uses. 

FullMono.PLT – For plan sheet production. This will plot all colors, regardless of 
how they are displayed, as black, except for the following:  

 Color # Plotted Color Color # Plotted Color 
232 Dark Gray 241 SHA logo blue 
233 Gray 242 Orange 
234 Gray 243 Yellow 
235 Gray 244 Blue 
236 Medium Gray 246 Light Green 
237 Gray 247 Green 
238 Gray 252 Light Red 
239 Light Gray 253 Red 
240 SHA logo orange 254 White 
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HalfMono.PLT – Identical to FullMono.PLT. However, line weights are scaled for 
11 x 17-inch prints. 

FullColor.PLT – For full-sized sheets. Colors print as they appear on screen. 

HalfColor.PLT – Identical to FullColor.PLT. However, line weights are scaled for 
11 x 17-inch prints. 

The active driver name displays in the Plot dialog box, next to the icons. You will 
normally use “printer.plt” for your plots. This driver maps to the Windows system 
printer driver. If you want to change the plotter driver so that you do not have to use 
the Windows system printer, follow these steps: 

1. Click the Plotter Driver button, the icon farthest to the right. 

2. From the Select Plotter Driver File dialog box, select the appropriate plotter 
driver. By doing that, you are indirectly selecting the size of the plot you are 
going to generate. 

Specify Plot Size: 
With the correct plotter selected, the next step is to verify the size of the plot. This is 
done via the Page Setup icon on the plot dialog box. The Page Size field allows you 
to select your plot output size. 

Set Scale Factor: 
You can set the scale factor in two different ways: 

1. Key in the master units to plotter units directly. 

2. Key in the size as a percentage of normal, and let MicroStation calculate the scale.  

Keep in mind that this is the ratio of design file master units to plotting units. This 
means that if you are plotting a drawing created using feet, and the scale is 4 feet per 
inch, this results in a final ration of 48:1 (48 inches, the drawing submit, to 1 inch of 
paper). 

The scale factor and the four fields in the Margins section of the Plot Layout dialog 
box are interlinked. When you change one, the other values are automatically updated 
to reflect the change. 

Maximize Plot (Optional): 
Sometimes you may want to plot the contents of a fence or a view at the maximum 
size of the plotter’s chosen paper size. You can achieve that by enabling the 
Maximize check box. This results in the chosen drawing area being plotted to the 
extents of the plotter’s page size. This is also the default condition, when you first 
enter the Plot dialog box. 
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Center Plot (Optional): 
The Center to Page check box shifts the entire plotted area to the center of the 
chosen page size. In many cases, the plot area you have selected doesn’t use the same 
height-to-width ratio as the page size. Using the Center to Page option makes the 
final plot look more like a finished drawing and may eliminate the need to trim the 
paper plot after the fact. 

Rotate 90: 
The Rotate 90 Degrees option on the Page Setup dialog box is similar to a 
portrait/landscape option on printer drivers. Many times your design will fit more 
economically on a sheet of paper if you rotate it 90 degrees. 

Plot Options: 
The Plot Options icon brings up a list of additional options for plotting your drawing. 
Some of the options could be dimmed, because they are displayed just for 
information. If you want to modify any, you will need to do it in the View Attribute 
dialog box in the Settings menu. 

Preview Your Drawing Plot: 
Before actually generating your plot, you have the option to preview its appearance 
right in the Plot window. This is done via the Preview Refresh icon. This is very 
helpful for seeing the effect of line weight definitions within the plot driver file and 
other key data. 

Transmit Drawing to Plotter: 
Follow the next two steps to create the plot: 

1. Click on the Plot icon, which launches the plot if “printer.plt” was your driver.  

2. If a driver other than “printer.plt” is selected, you are prompted for the filename 
into which the plot data will be placed. The default extension of this file is .000. 
MicroStation will then create a plot instruction data file for processing by the 
plotter later. 

The most common method for transferring plot data to the plotter is to use 
MicroStation’s PlotFile batch program. From the DOS prompt, key in PLOTFILE 
filename and hit Enter. While transmitting the plot file to the plotter, the 
computer will not be available for other work. 
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Using the HD BW Image Printer (I-Plot Monochrome Raster Offline 
Driver) 

The HD BW Image Printer creates a TIF file, and is the preferred solution to generate 
full-size black-and-white images that look just like plan sheets. The process is 
identical to plotting, except the printer is selected as the HD BW IMAGE on 
HDDPLOTPC. If you were to plot the images that the driver generates by using any 
standard image editing program on the same size paper it will very closely match the 
prints that were generated, including pen tables and any effects applied through I-
PLOT or a MicroStation .PLT file.    

You can actually print from any windows software to HD BW Image, such as Excel, 
Word, or PowerPoint. 

The resolution is high enough for full-size plots with clear text and symbols, and the 
file size is small enough to run the files through an Internet Web viewer or put 
hundreds of plan sheet images on a single compact disc. The small file size for such a 
high resolution is accomplished because the driver generates a Monochrome (Black 
and White only) image. However, it goes further than strictly turning all colors into 
solid black. The driver transforms shades of gray or colors into finely speckled black.  
From a distance, the speckles appear gray.  

 

A printed plot document using an HD BW Image Printer 

The process is identical to plotting, except the printer is selected as the HD BW 
IMAGE on HDDPLOTPC. 

When using MicroStation’s standard File > Print command, select the following: 
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Printing a fence using a Windows printer 

 

Selecting the appropriate printer 
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When using MicroStation’s add-on I-PLOT printing software, select the following: 

 

 

You can also use the InterPlot Organizer to print out an entire job. In any case, the 
images will be created in the folder called HD BW Image.  

IMPORTANT: Once the files are generated at this location, they should be copied to 
the appropriate project directory. ONCE A WEEK, THE FILES IN THIS 
FOLDER WILL BE AUTOMATICALLY DELETED WITH NO PRIOR 
NOTICE. 

In addition to the folder where images are printed out, the Administrator implements 
several important settings on the plot server, outlined in Appendix A, pages 5-13 to 
5-17. 
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Admin Settings for I-Plot Monochrome Raster Offline Driver 
HD BW Image is the I-Plot Monochrome Raster Offline Driver printer. While 
numerous settings exist, here we explain: 

• Setting a File-Naming Pattern 

• Creating a custom-size plan sheet  

All the settings are accessed through the Control Panel>Printers.   

 

Right-click on the correct Printer, and select Properties.  

Setting a File-Naming Pattern 
Make sure you are on the Ports tab, as shown below.   

 

Highlight HDImage and select Configure Port.  
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The menu above shows the current directory where TIFs will be stored as well as the 
Naming Pattern for files that are generated through the printer, which is to use the 
DOCROOT, or filename without extension, and add the .tif extension at the end.  
Select Pattern Setup to change these settings. 

 

You can use any combination of variable names to create your pattern.  Use the Help 
tab for explanations of the variables. You may also type characters; in the case below, 
the .TIF was added so that the file automatically receives the correct file extension. 
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Setting a Custom Page Size 
Make sure you are on the Device Settings tab of the printer Properties window as 
shown below.   

 

Select InterPlot Device Attributes, and you can set up a custom size using the menu 
below. 
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Generating Images from MicroStation Files 
Typically, drawings are printed and reviewed, and often users need to create an 
electronic image of the drawing. This provides the ability to share the information, 
saves money on paper and ink, and allows for a faster distribution with no delivery 
charges.   

Depending on the purpose, you may want to generate the entire project, a drawing 
sheet, or a close-up view to focus on an issue. Some applications include:  

• Creating an archive of construction documents that can be printed from any 
image software 

• E-mailing sheets or views for fast review and action 

• Inserting pictures of drawings into other documents (Word, PowerPoint, 
CorelDraw, PhotoShop, and so on) 

• Renderings/Displays 

Three ways to generate images from CAD files will be discussed. 

• Using the HD BW Image Printer (I-Plot Monochrome Raster Offline Driver) 

• Using a customized Image Plot Driver (PLT) 

• Using Utilities>Image>Save 

Using a Customized Image Plot Driver (PLT) 
Through MicroStation’s Standard Print dialog box, the user selects a .PLT file.  Most 
consider .PLT files as a way to select the printer, but you can also select drivers that 
produce images. The TIFF.PLT that was delivered with MicroStation was customized 
in three forms, all of which plot in landscape view and in full color.  

These generate plots that appear with similar line thickness and appearance as a 
normal plot, including white background. 

When using MicroStation’s standard File>Print, select the following: 
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Depending on the application, select one of the following: 

TIFF_22by34INCH.PLT – Produces high-resolution images that contain 200 dpi 
when printed at 22 by 34 inches. File size is high – around 2250 KB. 

TIFF_11by17INCH.PLT – Produces high-resolution images that contain 200 dpi 
when printed at 11 x 17 inches. File size is moderate – around 800 KB. 

TIFF_PPT.PLT – Produces images that are 1024 x 768 pixels in size, which is 
appropriate for PowerPoint presentations, inserting smaller images in documents, or 
e-mails.  File size is low – around 140 KB. 

Using Utilities>Image>Save   
This is useful primarily in 3D renderings as the various rendering shadings (e.g., ray 
trace) are available. It has been applied to 2D drawings using wireframe shading to 
generate plotlike images.    

The results will be WYSIWYG, except that you can generate an image of as high a 
resolution as you desire. 
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A saved, full-color product using Utilities>Image>Save 

 

What’s Next? 
The remaining sections of the manual are appendices providing various information.  
Appendix A contains a glossary of terms and abbreviations for help deciphering what 
you have just read. 
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Notes 
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Appendix A 
Glossary 

This glossary was developed to ensure that terms were consistent in this manual and with SHA 
practices, recognizing that meanings may differ when used outside the context of these 
Standards. 

 
Term or Abbreviation Definition 
Attribute Property, such as color or style, of an element or entity 
Addendum Making a change to a construction project. See 

Redlining. 
AutoCAD Computer-aided design software that runs on personal 

computers 
Barmenu In V8, “Barmenu” itself is a freely available and 

customized MicroStation Development Language 
application. The executable file extension is *.ma. 
They set symbology and initiate standard commands for 
drawing elements, also known as features. The features 
are arranged in a logical hierarchy on the 
Barmenu. Different File Disciplines and Purposes will 
have their own Barmenus, and each Barmenu should 
contain only those features belonging in a specific file.   

Base linens Borders. This term was used in the hand-drafting days. 
CAD Computer Aided Design and Drafting 
CADD See CAD, the more commonly used abbreviation 
Category Code Number A cell description convention consisting of two numbers 

enclosed in parentheses, which permits programmers to 
create and write utilities which count cells and tabulate 
them based on more than one thousand Category Code 
Numbers. 

CEC Consulting Engineers Council 
Cell A complex element composed of a group of primitive or 

other complex elements that is stored in a cell library for 
repeated placement.  

Cell Library A file used to store cells. To access cells in a cell library, 
the library must be attached to the active DGN file, 
except if the Cell Selector dialog box is used.  

Check-In Process of restoring a checked-out file to the server 
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Term or Abbreviation Definition 
Check-Out Process of copying a file from the server for exclusive 

editing rights 
Clip To divide an area, elements, or portions of elements in a 

design for manipulation or display 
Clip/Clipping Boundary A boundary (established with a fence or from a named 

view) that separates the part of a reference that is 
displayed from the part that is hidden. 

Clip Mask Used with the Raster Manager or Reference tools, a clip 
mask allows you to clip out a portion of the image. 
Masking can be used, for example, to clear an area for 
text display. 

CSV File Comma-separated values file: The CSV file format is an 
interchange format for tabular data, such as the contents 
of a flat file database or a table in a relational database. 
In this text file format, the first line contains the database 
field (column) names separated by commas. Each 
successive line corresponds to a database record (row). 
On each such line, commas separate the subject record's 
field values. 

 
Design Rules 

Component interactions that provide flags for the 
designer when a design does not meet SHA design 
criteria. 

Detail A file type used to sketch identifying construction or 
design details 

Dimension Styles 
(Attributes) 

Three new ones have been created: Civil, Structural, and 
COGO, the coordinate geometry programming language. 
These are the settings for all components of dimension 
elements, including text (color, weight, font, height, and 
width), lines (color, style, weight, and alternates), and 
level. 

Discipline-specific Seed 
File 

A template used to create CAD drawings. It’s a blank 
design file with appropriate SHA-specific working units 
and other settings to create custom files for each 
Division’s use. 

Display Final product of CAD files intended for plotting, 
including any plan, profile, and cross section sheets, 
schedules, wall displays, and other files. 

Drawing Scale Drawing scale helps to maintain consistency of scale-
dependent drawing features, regardless of the scale used, 
including text, line styles, and cells. 

DTM Digital Terrain Model 
DWG A file extension denoting drawing files 
DGN A design file in MicroStation/J and version 7 
DGNLIB In MicroStation V8, the Design File Library 
EAPD Engineering Access Permits Division 
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Term or Abbreviation Definition 
EWO Extra Work Order. It refers to changes in a construction 

project. 
EIM Engineering Information Management 
Export To send data from an application to another source 
Feature Single type of design information within a file type. 

Uniquely identifiable by its level, color, weight, and 
style. 

Feature Owner Office or Division that is designated as an owner of a 
CAD feature and defines its attributes. 

Feature Stakeholder Office or Division that should be consulted by a Feature 
Owner when defining its attributes. 

Feature User An engineer or designer who uses a feature when 
creating a drawing. 

File Discipline Broadly describes, the discipline of information 
appearing within a particular design file in terms of 
whether it is highway design, survey, drainage design, 
signage, or pavement marking. 

File Group Groups under which file types are categorized. 
File Group Describes the general purpose that the individual files 

serve as part of the larger CAD production workflow: 
Model, Existing, Proposed, Detail, Print, and DGN 
Support 

File Type A CAD file containing a specific type of information, 
namely, Model, Display, or Detail. 

Fence A polygonal boundary that designates multiple elements 
for simultaneous manipulation using fence tools. 

HD File In the V8 Standards, a Horizontal Design file, 
encompassing the horizontal location of the road 
centerline, edges, sidewalks, cut/fill, and other design 
elements. It replaces an HA file in V7. 

HDD Highway Design Division 
HHD Highway Hydraulics Division 
IDS Integrated Design System 
IDSIM  Integrated Design System Information Manager. It 

maintains the list of CAD features with their unique 
symbology (color, level, weight, and so on). IDSIM 
tracks changes as they are made to the Standards, 
allowing for version control (version 1.0, version 2.0, 
etc.). IDSIM facilitates adherence to the standards by 
allowing CAD Managers to design, modify, and generate 
*.MDF files that drive the Barmenu. 

IDS Tool Box A group of MicroStation add-ons. It is not a single item, 
but a collection of SHA-specific programs. 

IFB Invitation For Bid 
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Term or Abbreviation Definition 
IGDS Interactive Graphics Design System, the software that 

ran on Intergraph VAX-based CAD systems 
InRoads and GEOPAK Civil engineering add-on programs used with 

MicroStation 
I-PLOT A MicroStation add-on that allows for greater usability in 

plotting 
InterPlot Bentley’s digital plotting management program 
InterPlot Organizer MicroStation plot organizer that allows you to print out 

an entire job. 
I-PLOT Plus An improved version of I-PLOT that automatically 

calculates the other value to maintain the aspect ratio of 
the plot. 

IPARM A file containing plot parameters and other data. An 
IPARM file must be created before executing a plot. 

Key-in/key in An instruction entered into the Key-in window to control 
MicroStation. Most key-ins have graphical user interface 
(GUI) control equivalents. To “key in” means to enter 
this information manually. 

Levels Named slots for information in a file. MicroStation V8 
allows the user to create an unlimited number of levels. 
Their display can toggle on or off, allowing users to have 
lots of information saved in one file, even if the material 
does not need to be used or viewed at the same time. 

Level Filters Level filters limit the number of levels that appear in a 
level list. They also turn groups of levels on and off 
when needed. 

Line Style A part of the symbology of an element, for example, 
whether a line is solid, continuous dashes, dots and 
dashes, and so on. Each element can have its own line 
style or each can be defined by separate symbology. You 
can create custom line styles. 

Metafile  A file that creates or defines other files. It’s commonly 
used when creating directories. 

MDL MicroStation Development Language. The extension of 
the executable file is .MA. 

.MDF File extension for a MicroStation Database File 
MDSHA/SHA Maryland State Highway Administration/State Highway 

Administration 
MicroStation V8 Version 8 of the MicroStation CAD software 
MicroStation J Version 7 of the MicroStation CAD software 
Model Files Coordinately accurate drawings, usually in 3D format 
Non-DGN Support Files critical to CAD design, but are not themselves CAD 

files  
OBD Office of Bridge Development 
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Term or Abbreviation Definition 
OED Office of Environmental Design 
OOC Office of Construction 
OMT Office of Materials and Technology 
OFIT Office of Finance and Information Technology 
OHD Office of Highway Development 
OOTS Office of Traffic and Safety 
OPPE Office of Planning and Preliminary Engineering 
ORE Office of Real Estate 
PPD Project Planning Division 
Plan Sheets Same as Detail Sheets. They show all the design work for 

a project. 
Plotter An instrument that graphs the final output of a 

MicroStation drawing 
PLT/.PLT A customized image plot driver/a plot file extension   
Plotting Plotting refers to using a printer or large-format plotter to 

print hard copy on paper from CAD drawings. 
PlotFile A MicroStation batch program that transfers plot data to 

the plotter 
Print Files Files where all text, such as tables and construction 

schedules, should be placed that cannot be directly 
referenced from a Model file. 

ProjectWise An EIM system that manages file version control and 
tracking 

PSD Plats and Surveys Division 
Redlining The process of making changes to a construction site, 

which involves a great deal of coordination and 
paperwork  

Reference File A design file attached to an active design file. Elements 
in a reference file cannot be manipulated. 

Seat Refers to software license 
Settings Manager A settings file is an import or export file that stores all 

settings for a particular conversion as they were when the 
settings file was created or last saved. Also, a type of 
module data (“.stg” files) that specifies active settings 
and drawing tool selections; used with the Select Settings 
window. The Settings Manager oversees all this. 

Sheet file A large design file printed in hard copy, similar to 
architectural plans 

State The last known or current status of an application or 
process 

Storage Area A designated directory for storing files 
Sub-feature When two different types of design information share the 

same level, color, weight, and style, but differ by some 
other parameters (e.g., text size or cell name) 
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Term or Abbreviation Definition 
Symbology Refers to level, color, style, and weight of a drawing 

object 
TEDD Traffic Engineering and Design Division 
Text Styles New to V8, text styles are used to apply standard text 

attributes to newly created text. The active Text Style 
applies to placed text, annotations, tags, and other 
element types that use text. 

.TIF or .TIFF Tagged Image File Format 
Tool Frames A tool box that has smaller tool boxes 
Topo Files Topology. Files containing maps and surveying 

information 
Vault File storage spaces for engineering documents  
Wireframe A display mode in which surfaces are displayed as their 

outlines, and elements behind surfaces are displayed as 
though the surfaces did not exist. 

Work Area Workspaces with the same measurements in a file 
Work files Nonstandard files used for engineering, calculations, and 

measurements by the designer. They are scrap paper and 
a backup of the person’s work 

Workflow A defined sequence of procedures 
Workmode An operating mode of MicroStation, such as DGN, 

DWG, and V7 workmodes 
Workspace A custom MicroStation environment or configuration 
Workspace Preferences 
Menu 

The menu SHA employees use to set up individual 
MicroStation workspace 

Working Units Real-world units that the design plane is configured to. 
Working Unit Settings The settings that designate the working units and 

working resolution. 
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Appendix B 
Engineering and Design Workflow  

The Maryland State Highway Administration manages all facets of the state highway 
network—from planning and design, to construction, operations, and maintenance.  

The primary types of project documents fall under the main categories of 
specifications, estimates, and bid drawings.  Specifications are a collection of bid 
items needed in project construction.  They cover accepted construction parameters 
and the approved products to use, as determined by the Category Code Book and 
Book of Standards, common references that contractors use.  Estimates outline the 
cost of the entire project, broken down by item.  Engineers create CAD drawings to 
solicit bids based on proposed designs and alternates.  Most importantly, they are 
visual representations of the projects.  Traffic signs, roads, bridges, Metro stations, 
and other infrastructures cannot happen without them.  It is crucial to establish 
standards and automation tools for the production of all of these documents.  The 
myriad benefits are obvious. 

SHA’s planning and design offices use CAD extensively to create concept and detail 
drawings of proposed construction projects.  Construction, operations, and 
maintenance offices use the products created by CAD, specifically engineering 
drawings, to build, operate, and maintain highways and associated structures. 

The design cycle for a large project, such as building interstates or bridges, can take 
up to two years.  This meticulous work covers surveying, calculating engineering 
computations, and creating CAD files.  A CAD file is a MicroStation file with the  
.DGN extension, or it can be an AutoCAD file with the extension .DXF. SHA only 
uses MicroStation. 

Large projects can have eight to twelve such teams working on them.  A team in any 
given discipline is usually three people: a supervisory engineer and two supporting 
engineers, each with varying years of experience.  The Traffic Division alone handles 
400 signal design projects every year.  Single-person teams handle small projects like 
traffic lights.  These might take up to four weeks to complete.  The administrative 
support staff provides all teams with assistance as needed in preparing contracts and 
bids, maintaining meeting calendars, making telephone calls, and more.  

Entry-level engineers are expected to have a civil-engineering background and the 
ability to read technical drawings, and perform the required computations to 
determine alignments, soil and concrete strength-based member sizes, cross sections, 
cut/fill areas—anything that the specific project requires. As time progresses, 
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engineers and all other employees should develop a working knowledge of the 
finances involved, zoning restrictions, and state, county, and municipal budgets. In 
addition, they should be able to describe basic procedures. 

Designing a highway requires input from several disciplines.  For example, highway 
planners explore various alternatives within the context of constraints imposed by a 
specific project and its environments.  Highway design engineers develop horizontal 
and vertical alignments for highway centerlines to ensure they meet regulatory and 
safety guidelines.  Hydraulic engineers design storm drain systems to ensure that 
highways do not flood during rainstorms.  Bridge engineers design bridges across 
streets and waterways to bypass obstructions and create interchanges.  Traffic 
engineers design traffic signs, streetlights, and pavement markings.  Surveyors take 
measurements of existing terrain to help engineers conduct design studies. 
Geotechnical experts test soils and construction materials to ensure they meet design 
requirements and specifications. 

Considering the diversity of expertise needed in the creation of engineering design 
drawings, many specialized workgroups collaborate daily.  To provide a sense of the 
effort required for the design of complex projects, here is an example.  A large 
highway design project can take up to two years in the design phase, with 
involvement from nearly thirty engineers working full time.  The Woodrow Wilson 
Bridge project will take ten years to complete.  The number of design drawings for a 
complex project can reach a thousand. 

Clearly, people from diverse disciplines must work together on highway projects.  
The quality of collaboration between design disciplines dictates whether a project will 
succeed, both in terms of the quality of coordinated drawings produced and the 
reduction of construction errors and omissions. 

These CAD Standards were developed to facilitate collaboration among disciplines 
and improve the quality of CAD deliverables, namely engineering drawings. 

This chapter has three major sections, as listed below. 

• Office Responsibilities introduces you to the various offices within SHA 
and their roles and responsibilities.  

• Engineering Workflow across SHA Offices explains the CAD workflow 
and which types of drawings are typically created by which disciplines. It 
explains the collaboration software that SHA adopted to facilitate inter-
Departmental interaction.  

• Collaboration Tools describes the benefits that can accrue from using 
these Standards: the development of easy-to-use productivity-enhancing 
tools. This section identifies the basis for using CAD and the software 
used in engineering design.  
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Office Responsibilities 
A working knowledge of the interrelationship of SHA Divisions, Offices and their 
specific functions offers a broader awareness of the Administration’s mission and 
public service while promoting a greater level of teamwork. Here is an overview of 
the responsibilities of each SHA Office:  

• The Office of Planning and Preliminary Engineering (OPPE) prepares 
maps. OPPE coordinates statewide transportation planning with federal, state, 
and local agencies, and conducts preliminary engineering and alternate 
analyses for budget planning purposes. 

• The Office of Highway Development (OHD) designs highway and support 
structures like drainage systems along the selected alternative to meet design 
guidelines. They conduct surveys to provide detailed topographic maps for 
design. With six Divisions—Highway Design, Highway Hydraulics, Design 
Technical Services, Communication Design, Plats and Surveys, and 
Engineering Access Permits, OHD oversees projects from the program stage 
until they are advertised for construction. 

• The Office of Bridge Development (OBD) designs bridges and other 
structures such as retaining walls and noisewalls, ensuring quality and safety 
while employing the latest technologies. 

• The Office of Environmental Design (OED) deals with highway-related 
environmental concerns, including sound barriers, retaining walls, landscapes, 
forests, wetland mitigation, byways, rest areas, and more. 

• District Offices perform design, construction, safety, and maintenance for 
highways falling under their jurisdictions.  

• The Office of Maintenance (OOM) is charged with the upkeep of state streets 
and highways. 

• The Office of Materials and Technology (OMT) tests materials for the 
planning, design, construction, and maintenance offices, focusing on safety 
and durability. Contractors might use hot-mix asphalt, concrete, metals, 
structural coatings, and the like to build highways and structures.  

• The Office of Traffic and Safety (OOTS) designs lights, traffic signals, street 
signs, and traffic control devices and promotes highway safety.  

• The Office of Construction (OOC) deploys inspectors to investigate and rate 
contractor effectiveness, ensuring project quality and safety. 

• The Office of Real Estate (ORE) deals with legal issues related to right-of-
way acquisitions and property plats. 
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• The Office of CHART and ITS Development deploys and monitors 
intelligent transportation systems (ITS), such as cameras and sensors, to 
promote intelligent traffic adjustments to maximize infrastructure usage. 

Engineering Workflow across SHA Offices 
Each Division developed its own discipline-specific workflows that contain 
specialized processes that occur solely within its section.  This workflow must be 
adhered to in conjunction with these CAD Standards. 

Some Divisions have processes so specialized and separate from the rest of SHA that 
they have deemed in the past that the scope of their CAD design resides outside these 
rules.  For example, OBD deals only with bridge structures, and other Divisions 
require only bridge outlines in their drawings, allowing OBD to stay apart from the 
SHA CAD Standards.  While valid reasons exist for this, the IDS Team strongly 
encourages using this CAD Standards manual wherever possible.   

Before work can be assigned to contractors for construction, it is SHA’s 
responsibility to conduct surveys and collect any relevant data and permits. 

Planning Phase: Project Planning Division, Engineering 
Access Permits Division, et al. 
A typical SHA project must first be evaluated to check that project work is possible 
without disrupting existing structures, topological features, or crossing outside proper 
boundaries.  

Field surveys and property boundary information are essential to developing a good 
foundation for any project. The Plats and Surveys Division (PSD) is the primary 
surveyor and collector of topological data at the site of proposed project work and 
maintains a repository of up-to-date survey data. Their primary functions include the 
identification of topographic features and property boundaries that can influence the 
design and costs of projects as well as property impacts. When all the survey data is 
collected, PSD produces a Digital Terrain Model (DTM) that other Divisions will use. 

When a project is in the planning phase, surveys are less detailed.  However, they 
may include aerial photography and photogrammetric maps.  These are not as 
accurate as ground surveys, but they are less expensive.  This is money well saved, 
since the project may not be approved for design for several years. Property maps in 
the planning phase are from approximate tax maps.  Legally binding property maps 
for final designs are generated later. 

The planning phase encompasses functions like the development and acquisition of 
engineering mapping, preliminary engineering, and acquisition of required permits to 
perform project work.  Various construction proposals intended to solve 
transportation problems are studied, such as the Intercounty Connector (ICC).  The 
impacts and benefits of such construction are evaluated, and a preferred solution is 
selected for the design phase. 
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The Project Planning Division takes on the project production activities necessary for 
obtaining federal and state agency approvals that allow a project to advance to the 
design phase.  The Engineering Access Permits Division (EAPD) also assists in 
planning by processing permits pertaining to state highway access. 

Design Phase: Highway Design Division, Office of Traffic and 
Safety, et al. 
When a project is approved for design, it moves out of the Project Planning Division 
and into the hands of the Office of Highway Development.  The Plats and Surveys 
Division provides a more detailed ground survey as necessary, including a 
topographic map and a DTM.   

 The designer's primary job at this point is to produce final construction documents 
for the chosen alternate.  The designer generates a centerline with horizontal and 
vertical alignment of the corridors and intersections to be constructed, usually with 
InRoads or GEOPAK design software. 

In designing the corridor—another term for a road, highway, street, avenue or related 
term—the designer generates a centerline with horizontal and vertical alignment with 
InRoads or GEOPAK design software.  Horizontal alignments are commonly 
tangents and arcs.  Vertical alignments are usually tangents and parabolas.  One 
advantage of using InRoads or GEOPAK is that in the final construction documents, 
all items and quantities are staked out relative to the centerline in terms of a station 
(the distance along the alignment) and offset (the perpendicular distance from the 
alignment).  The design software calculates these values, which eliminates the need 
for the designer to take manual measurements.  

Another use of the design software is to create a typical proposed cross section and 
push it along the alignment at station intervals.  The intersection with the existing 
DTM is calculated at each interval to determine the cut/fill lines.  A DTM can be 
created that represents the proposed construction.  Rendering and visualization of the 
model may also produce something for community presentations and alternate 
selection.  

What is now known as a Horizontal Alignment (HA) file in the V7 Standard was 
renamed to a Horizontal Design (HD) file in the new V8 Standards.  This avoids 
confusion that only the alignment data should be in the file.  All of the information 
about the horizontal location of the road (centerline, edges, sidewalks, cut/fill, etc) is 
contained in the Horizontal Design (HD) file.  Once the HD file is set, the Plats and 
Surveys Division will see that legally binding right-of-way lines are drawn up for all 
affected properties.  Based on this information, the Office of Real Estate will 
negotiate with property holders. 

It is crucial that all files in V8 use the new file-naming convention in Chapter 2 to 
facilitate the collaboration between designers of different disciplines.  While the 
Highway Design Division creates an HD file, other related auxiliary structures that 
need to be shown on the same printed sheets are created by their respective Divisions- 
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i.e. inlets and pipes are drawn by Highway Hydraulics, signs and pavement marking 
are drawn by the Traffic Engineering Design Division, etc.  These are all attached to 
the plot file as reference files.        

Collaboration Tools 
Over the past few years, SHA adopted several tools to manage engineering 
documents.  Collaborative technologies of various systems make up the Engineering 
Information Management (EIM) System, an idea the IDS Team embraces.  The 
addition of such tools facilitates process workflow and improved internal and external 
communications. 

ProjectWise V8 
ProjectWise is the Engineering Information Management solution SHA began 
deploying in Fall 2003.  The ProjectWise application supports potentially disparate 
workflows by managing its secure file repository using check-out and check-in 
procedures in real-time operations.  Decentralized engineering content is consolidated 
into a single location to ensure that all project team members have access to the 
correct data when they need it.  

Furthermore, ProjectWise is designed to handle MicroStation DGN and AutoCAD 
DWG files, as well as other business file formats such as MS Office files.  Refer to 
ProjectWise documentation for detailed instructions on using ProjectWise. 

MicroStation V8 
MicroStation V8 is the current version of Bentley’s CAD software adopted by SHA. 
The upgrade from MicroStation J to MicroStation V8 marks a new milestone in CAD 
technologies, introducing several new features: 

• File format change; 

• Changes to clipping plot files for easier manipulation; 

• Unlimited levels associated to a file. 

Details on standardizing MicroStation CAD drawings appear in Chapters 1.  SHA’s 
V8 standards are designed to work with MicroStation Version 08.01.02.15 or later. 

Civil Engineering Applications 
SHA uses two civil design software applications, InRoads and GEOPAK, on top of 
its CAD drawings.  SHA is currently seeking to standardize on one of the two 
packages in order to lend focus to future development efforts.  

GIS Attributes 
GIS Attribute flags are necessary to create the needed GIS layers from the CAD File. 
These features must be accommodated. Such features include traffic signals, storm 
drains, and culverts. 
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Custom software to support workflows will make it easier to work together. 
Numerous custom utilities, such as Bar Menus, IDS Toolbox, gINT Blog, MCPC, and 
several others are delivered with the Standards.  These utilities simplify adherence to 
Standards while promoting consistency and efficiency. 

These tools automate the process of creating and drafting project plans.  They ensure 
that the plotted final result will be consistent and legible.  By developing the files 
consistently, we are imparting “intelligence” into the files. In other words, the various 
items in the file are coded consistently with a knowledge base that tells us what the 
items are representing.  This intelligence is the foundation for further application 
development that relies on scanning the file for the features based on the consistent 
end product.  Some examples are below: 

• Estimating: Adherence to CAD Standards feature tables accommodates 
developing Engineering Estimates from the files, as each feature can be 
identified and quantified by its unique symbology. 

• Specifications/IFB Generation: CAD Standards accommodate developing 
an Invitation for Bids or Specifications Book from features used in the design 
files.  For example, if CAD features are designed consistently throughout the 
project plans, each is assigned a number in a central repository, and users 
select only what they need. 

• Design Rules: CAD Standards accommodate Design Rules. Design Rules are 
the component interactions that provide flags for the designer when a design 
does not meet SHA design criteria.  For example, during the placement of a 
signal pole, a flag appears, indicating that it is too close to the curb line and 
does not meet SHA criteria.  Therefore, it must be placed in a new location. 

What’s Next? 

Chapter 2 covers  
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Appendix C 
History of CAD at SHA 

The Maryland State Highway Administration (SHA) is the largest agency within the 
Maryland Department of Transportation. Its headquarters office in downtown 
Baltimore is home to the Office of Administration, Office of Finance and Program 
Management, Office of the Chief Engineer of Operations, and the Office of Planning 
and Engineering. SHA maintains several other buildings in the Baltimore area that 
house various parts of its Engineering and Operations sections. 

Additionally, SHA operates seven District offices to serve the local needs of Western 
Maryland, the Frederick Metropolitan Area, the Washington Metropolitan Area, the 
Baltimore Metropolitan Area, the Northern and Eastern Shores, the Southern Eastern 
Shore, and Southern Maryland. 

Considering the size of the organization and the geographic distance between Offices, 
the task of unifying procedures and processes was quite a challenge. 

1986 – Two Independent CAD Initiatives at SHA 
Drafting SHA’s engineering plans for highway construction and rehabilitation 
projects is a significant task. Up until 1986, this job was accomplished by 
draftspersons using paper and pencil. Engineers developed the design through 
analyses and computations and worked with draftspersons to put it together on a 
drafting board as a construction document. As the design progressed, modifications 
were carefully made directly on the original paper plan with pencil and eraser. 

OOTS Selects AutoCAD on PCs 

The Office of Traffic and Safety (OOTS) watched the growth of PC-based CAD 
software. In mid-1986, OOTS decided to bring in approximately fifteen IBM PCs and 
four D-size pen plotters to run AutoCAD for drafting traffic-engineering plans. 

OOTS selected AutoCAD running on PCs because it was cheaper than IGDS 
(Interactive Graphics Design System), the leading CAD solution at the time that ran 
on Digital VAX minicomputers. 

Headquarters Selects IGDS on VAX Minicomputers 

SHA’s headquarters office also had been watching the CAD industry and 
investigating various alternatives to assist its engineering plan preparation efforts. 
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After much deliberation, it opted for IGDS, the solution already adopted by several 
DOTs. IGDS offered three-dimensional design and multiuser capabilities well suited 
to organizations the size of SHA. 

In November 1986, the SHA headquarters office ordered two VAX 11/785 
minicomputers connected to six Intergraph 32c workstations, one InterView 
workstation, and one high-speed electrostatic plotter. 

1988 – The First 100 Percent CAD Project at SHA 
In July 1988, after a couple years of running smaller pilot projects, SHA undertook its 
first major highway project that would be completed entirely in CAD. It was a six-
month project for the reconstruction of the US 13 interchange at Salisbury, Maryland. 
The project plan as seen within the CAD software is shown below. 

 

The first SHA All-CAD Project: US 13 Interchange Reconstruction at Salisbury, Maryland. 

All highway design drawings for the project were drawn in IGDS software at the 
headquarters office. OOTS staff created all project traffic-engineering drawings in 
AutoCAD software. 

Although IGDS and AutoCAD are both CAD software systems, they are completely 
incompatible. They each use different file formats, font files, symbol libraries, and 
customization languages. IGDS cannot work with AutoCAD files and vice versa. 
This incompatibility meant that one of the two systems would be phased out over 
time. 

IGDS Proves More Functional 
Intergraph, the developer of IDGS that was later named MicroStation, developed 
numerous civil, survey, and highway engineering design modules for its software. 
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The survey module, for instance, could download data from a survey gun and 
automatically create a topographical plan for a site. Use of the survey module 
represented dramatic time savings because one did not have to print data, run 
coordinate geometry computations, and then painstakingly draw pavement edges, 
curb lines, and trees. 

The availability of the survey add-on design module won over the Plats and Surveys 
Division to IGDS. As more and more projects began to be done in CAD, the offices 
regularly using CAD by 1991 included Cartography, Planning, Bridge Design, 
Landscape Architecture, Plats and Surveys, Highway Design, Soils and Foundations. 

In 1989, experienced users formed a CAD working committee. They met monthly to 
discuss CAD-related issues and address problems. All departments using CAD were 
involved. The most significant problem was compatibility between CAD files 
generated by the downtown office and OOTS. Because file format translations were 
labor-intensive and not good enough, the committee initiated a “no-translations” 
policy. AutoCAD users would re-create base drawings already in MicroStation. 

Though in the beginning the number of AutoCAD users was more than MicroStation 
users, the numbers weighed in favor of MicroStation as its use at headquarters grew. 
By 1990, the number of MicroStation users was several times larger than AutoCAD 
users. 

When the seven district offices needed to use CAD, senior management felt that 
because of the popularity of AutoCAD in the marketplace and at community colleges, 
it might be better to implement AutoCAD at the district level. Each District Office 
received one AutoCAD seat on a PC. The move toward adoption of AutoCAD had 
limited success in two years. Because of file format incompatibility issues, district 
CAD users requested MicroStation. 

By 1991, SHA had two hundred MicroStation users and thirty-five AutoCAD users. 
In July 1991, when MicroStation 4 came to the PC, employees attended numerous 
training classes in it throughout SHA, including OOTS. MicroStation became the 
official SHA CAD platform, and AutoCAD was phased out. A transition team formed 
to help AutoCAD users migrate to MicroStation. The transition involved translating 
AutoCAD drawings and symbols to MicroStation design files and cell libraries, along 
with a port of custom AutoCAD tools to equivalent MicroStation tools. 

Development of SHA CAD Standards 
On April 9, 1991, the first SHA CAD Feature Table was released—the first attempt at 
standardizing how MicroStation should be used at SHA. The guidelines required 
users to place a specific feature (curb line, pavement marking, utility line, pavement 
edge, and so on) with a specific color, thickness, and line style on a specific drawing 
level. Because conforming to standards required extra effort, the adoption of the 
feature table was sporadic at best. 
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In 1992, SHA managers saw a clear need to standardize CAD. They sponsored a 
Quality Team consisting of users from the Highway Design Division, Plats and 
Surveys, Project Planning, Environmental Design, and the Landscape Architecture 
Division. The goal was to make CAD Standards user-friendly. Participation was 
mandatory, and brainstorming sessions were held regularly. 

In 1993, SHA released its formal CAD Standards that documented a workflow 
heavily based on reference files to facilitate data sharing. File types were defined, cell 
libraries were created, font files were compiled, Standard borders were developed, 
and standard color tables were generated. Also, a custom application called CADSTD 
was commissioned to facilitate the adherence to the feature tables. 

 

The CADSTD program facilitates adherence to SHA feature tables. 

SHA requires consultants to use its CAD Standards on engineering projects. Many 
SHA Divisions also use them to a degree. Feedback was compiled over the next two 
years from in-house and consultant users. Revised SHA CAD Standards were issued 
in 1995. 

NOTE: The 1995 Edition of the SHA CAD Standards is the current official release of 
the document. A 1998 effort to release an update was never completed. 

Various offices, such as the Office of Bridge Development and the Office of Traffic 
and Safety, have developed their own CAD guidelines. They have also developed 
custom tools to enhance CAD productivity, as shown in the figure below. 
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The custom SIGNTOOL at OOTS simplifies the creation of traffic signs in CAD. 

In 1999, the Chief Engineer’s office sponsored a productivity forum where SHA 
engineers met to brainstorm ideas for improving the organization’s productivity. The 
Information Technology team identified the use of CAD at SHA as a prime target for 
attention. A sub-team’s informal studies led to the findings and recommendations in 
the forum report. 

Simultaneously, the Office of Highway Development, in conjunction with the 
University of Maryland, was investigating a program to develop engineers’ estimates 
from CAD files. The study determined that the technology was feasible; however, 
SHA CAD Standards lacked the detail to support such software. Again, this led to the 
conclusion that SHA needed to update and revise its CAD Standards. Furthermore, 
SHA was receiving feedback from its consulting engineering community indicating 
the need for SHA to comply with and upgrade its CAD Standards. 

The offices of the SHA Deputy Administrator and the SHA Chief Engineer took an 
active interest in the findings and recommendations. They saw the value of proposing 
an Integrated Design System that embraces earlier CAD Standards initiatives and 
seeks to implement them throughout the organization. 

Maintaining and Developing CAD Standards with Evolving 
Technology  
The release of MicroStation V8 is a significant milestone in CAD software evolution. 
It brings about a file format change and removes many limitations posed by the 
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earlier file format.  Furthermore, its integration with ProjectWise V8 brings together a 
more unified workflow throughout SHA.  As SHA prepared for its migration to V8, 
management and employees realized it was time to update CAD Standards as well. 
The SHA IDS (Integrated Design System) Team managed by Mike Lynch, P.E., was 
asked to develop and release a new edition of CAD Standards. 

The various Divisions within SHA have different workflows. In the absence of a 
universal Standard at SHA, each Division developed its own preferred methods of 
working that address specific needs. In some cases, these methods are firmly 
established and rigorously applied, while others have more informal Standards that 
are essentially shared and taught by word of mouth.   

CAD practices play a major part in the workflow at SHA. It is important that an 
established base of CAD Standards exist from which to draw upon in order to move 
forward in the workflow.  Almost all jobs are part of a larger effort where the work 
performed by one team directly affects others, whether it remains in the Division, 
spans across Divisions, or goes to a consultant for completion.  Therefore, if CAD 
drawing Standards have not been maintained or are improperly used, one party’s 
work burdens someone else.   

Furthermore, as a result of advances in CAD technology and the ever-constant 
process of developing and refining workflow at SHA, the CAD Standards must adapt 
over time to newer and better technologies.  These CAD Standards have been 
developed through extensive meetings across all sections of SHA and through much 
consideration toward the development of a uniform set of CAD Standards that will fit 
within the workflows of all involved. 
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 Appendix D 
Converting V7 Files to V8 

Purpose 
This section details the necessary steps to convert a set of MicroStation J files (V7) to 
the V8 file format for use with SHA’s V8 CAD Standards.  Key to the process is the 
use of a CSV Remapping file to ensure that such standard elements as levels, 
weights, & line styles match the new V8 standards.  Of these, mapping the line styles 
is most critical because the V8 resource files have changed and old custom line 
styles will not appear correctly otherwise.   

NOTE: Converting project files should only be done at the discretion of the project 
manager! 

Procedure 
1. Start MicroStation V8 and open any file.  If the file is V7 and you are asked to 

convert to V8, always choose NO.  Remapping tables must be used for 
successful conversion. 

2. Select Utilities > Batch Converter… 

 

3. Set the Default Output Format to V8. 

4. Set the Default Destination directory (it is recommended that you create a “V8” 
folder in your project directory for this purpose) 
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5. Select Edit > V8 Save Options… 

 

6. Click the Browse button (magnifying glass). 

7. Select the appropriate CSV file for the files you wish to convert (refer to the 
section of this document, “Selecting a CSV File”).  Base files have been created 
for your use and are located in the ..\Workspace\Standards\MDSHA_V8\data\ 
directory.   

8. Check the boxes next to the standard elements you wish to map.  (At a minimum 
you should have “Apply Line Style Mapping” checked on.  Fields that are 
disabled do not have any remapping defined in the selected CSV table.) 

 

9. Click OK. 

10. Return to the Batch Convert window and select Edit > Add Files… 
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11. Select individual files or entire directories and click Add to move them to the 
bottom window. 

Example 1: Single or Multiple Files 

 

Example 2: Entire Directory, including Subdirectories 
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12. When all files have been selected, click Done. 

13. Return to the Batch Convert window and select Process Batch Convert Job 

 

14. When the Files to Convert window appears, check to make sure you have selected 
the correct files, then click Convert. 

 
 

One by one you should see the text in the Status column change to Converted.  
When finished, open and examine the files to make sure conversion was successful.  
If not, delete all V8 files from the destination directory before trying again. 

Be sure to rename V8 files to fit the V8 file naming convention!  The new V8 
workspace contains a File Naming Wizard tool to help with the process. 
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Selecting a CSV File 
Several sample CSV files have been created to help get you started.  These are 
located in the S:\CADD\Workspace\Standards\MDSHA_V8\data\ directory.   

Mapping Entire Projects 

The file to use as a starting point is SHABase.csv – this is a generic remapping file 
that may be used for any file type since it does not take levels into account.  Only line 
styles and weights have been set up for conversion.   

Advantage: This is ideal for mapping entire project directories at once while still 
meeting the minimum criteria for using the V8 CAD Standards workspace.   

Disadvantage: Numbered Levels will remain in the converted file (as Level 1, Level 
2, etc).  These level names can be converted by hand at a later time as needed. 

Mapping Individual Files 

Some CSV files have been set up to convert specific file types (e.g. TO, HA, etc).  
While the TO file is generally good for all topo (owing to consistently applied V7 
standards), other mapping files must be checked prior to use to ensure that the level-
number-to-level-name definitions are consistent with the standard used by the current 
project.  (That is, if the V7 file doesn’t follow any particular level standard, then 
neither will the V8 output file.) 

In most cases, the file-specific CSV files already contain the standard V8 level names 
and descriptions. However, it is necessary for a project team member to check that the 
V7 level numbers match the project standards. 

Advantage: Works well for projects that have files which follow a consistent level 
standard.  The resulting V8 files will have a level structure that more closely matches 
the new standards.  This may be more worthwhile for projects that are just underway 
and will be around for a long period of time rather than those nearing completion. 

Disadvantage: A significant time investment may be required to get the level 
mapping correct for each file type in the project.  A separate batch conversion must 
be run for each file type. 

Procedure:  

1) If the CSV file exists for the file you wish to map, use Windows Explorer to 
copy it to your project directory.  If not, copy the SHABase.csv file to your 
local machine and rename it to match the correct file type. 

2) Use the Batch Converter to open the new CSV file (steps 1-6, above) 

3) Click the Edit button . 
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4) Examine the V8OutputLevel and Description columns, then input the 

appropriate level number in the Level column, using the format: %%1, %%2, 
%%3.  (i.e. %%1 = Level 1, %%2 = Level 2, etc.) 

 
If there are situations where features on one level have since been broken into 
multiple levels (see level 4 for edge of road, curb, & gutter pan in the figure 
above), you have a choice:   

Either (A) decide on the most appropriate level for all features to map to 
(probably ROAD-EDGE in this case, leaving the others blank), or (B) click 
the Show Optional Columns button at the upper left and add modifiers for 
Color, Weight & Style to distinguish between features. 

5) When finished, Save and Close the file, then test your remapping table by 
completing steps 8-14 on pages 2-4 of this document. 
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